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Multi-Camera 3

1 Multi-Camera

Overview

"Multi-Camera" allows multiple Canon DSLR cameras to be controlled by a single PC or networked
group of PCs. All of the cameras' controls remain fully operational when connected to the PC and
pictures can be taken directly using the camera's shutter release or remotely from the PC.

"Multi-Camera" is very similar to the standard, single camera version of "DSLR Remote Pro", but
without the photo booth options. Please see the section on multi-camera operation for details on
controlling multiple cameras. The rest of this help file is the similar to the single camera version of
DSLR Remote Pro.

New Product Name: "Multi-Camera"

In 2018 the product name was shortened to "Multi-Camera". It was previously known as "DSLR
Remote Pro Multi-Camera". Please note that some screenshots in this help file may still show "DSLR
Remote Pro Multi-Camera".

Note: please select the "Use legacy app name" option in Preferences if you wish to use the DSLR
RemoteLib.dll interface library to control the app from other apps.

Supported Cameras
Multi-Camera supports the following Canon cameras:

Canon EOS R5

Canon EOS R6

Canon EOS R

Canon EOS RP

Canon EOS-1D C

Canon EOS-1D X Mark Il

Canon EOS-1D X

Canon EOS-1D Mark IV

Canon EOS-1D Mark Ill

Canon EOS-1Ds Mark 1l

Canon EOS 5DS R

Canon EOS 5DS

Canon EOS 5D Mark IV

Canon EOS 5D Mark Il

Canon EOS 5D Mark Il

Canon EOS 6D Mark Il

Canon EOS 6D

Canon EOS 7D Mark Il

Canon EOS 7D

Canon EOS 80D

Canon EOS 77D/EOS 9000D

Canon EOS 70D

Canon EOS 60D

Canon EOS 50D

Canon EOS 40D

Canon EOS 30D

Canon EOS 250D/200D lI/Rebel SL3/Kiss X10
Canon EOS 200D/Rebel SL2/Kiss X9
Canon EOS 100D/Rebel SL1/Kiss X7
Canon EOS 850D/Rebel T8i/Kiss X10i
Canon EOS 800D/Rebel T7i/Kiss X9i
Canon EOS 760D/Rebel T6s/EOS 8000D
Canon EOS 750D/Rebel T6i/Kiss X8i
Canon EOS 700D/Rebel T5i/Kiss X7i
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Canon EOS 650D/Rebel T4i/Kiss X6i

Canon EOS 600D/Rebel T3i/Kiss X5

Canon EOS 550D/Rebel T2i/Kiss X4

Canon EOS 500D/Rebel T1i/Kiss X3

Canon EOS 450D/Rebel XSi/Kiss X2

Canon EOS 3000D/EOS 4000D - warning: please see notes below
Canon EOS 1500D/EOS 2000D/Rebel T7/Kiss X90

Canon EOS 1300D/Rebel T6/Kiss X80

Canon EOS 1200D/Rebel T5/Kiss X70

Canon EOS 1100D/Rebel T3/Kiss X50

Canon EOS 1000D/Rebel XS/Kiss F

Canon EOS M6 Mark Il

Canon EOS M50 Mark II/Kiss M2 - warning: please see notes below
Canon EOS M50/Kiss M - warning: please see notes below

Notes:

The Canon EOS 4000D (aka Canon EOS 3000D) is not recommended for multi-camera shooting
because it does not access for connecting external power nor does it have a remote release socket.
The Canon EOS M50 and Canon EOS M50 Mark Il are not recommended for systems where you
need to trigger all the cameras at exactly the same time because they do not have a remote release
socket.

Supported Operating Systems

Windows 10 (32-bit and 64-bit versions)

Windows 8 and Windows 8.1 (32-bit and 64-bit versions)

No longer supported:

Windows 7: Microsoft ended support for Windows 7 on January 14, 2020 and therefore we no longer
test or support our software on Windows 7.

Windows Vista: Microsoft ended support for Windows Vista on April 11, 2017 and therefore we no
longer test or support our software on Windows Vista.

Windows XP: Microsoft ended support for Windows XP on April 8, 2014 and therefore we are no
longer test or support our software on Windows XP

Maximum Number of Cameras per PC

The maximum number of cameras that can be controlled from one PC depends on the computer.
Most laptop and desktop computers should be able to control up to 16 cameras. Desktop PCs
generally have better power supplies than laptops and may be able to control more than 16 cameras
(one customer reports reliable operation with 77 cameras controlled from a single desktop PC).
Multiple PCs can be networked together to control larger numbers of cameras. Please see this page
for more information.

Triggering Cameras

Multiple cameras connected a single computer can be triggered via the USB connection but there will
be a delay of approximately 1/10 second between each camera taking a photo. For larger arrays of
cameras and more accurate synchronization (to within a few milliseconds) it is necessary to trigger the
cameras via their remote release sockets. Please see this page on the Breeze Systems' website for
more information.

Installing, Registering and Activating DSLR Remote Pro
Multi-Camera

When you install Multi-Camera you need to activate your license on each PC it is running on.
Activating the software is a quick and simple procedure if the PC has access to the internet, however,
we recommend activating the PC at least 48 hours before an event. You can still activate a computer
which does not have access to the internet, but this involves sending an email to sales@breezesys.
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Installing, Registering and Activating DSLR Remote Pro Multi-Camera 5

com and will take longer than activating the software online. The software can be activated on up to
two computers at any given time.

You must deactivate the software before making any hardware changes, upgrading or repairing
the PC, reinstalling Windows or reformatting a hard disk. The software can then be reactivated after
the work has been done.

Topics covered in this section:

¢ Installing the software
Uninstalling the software
Evaluating the software
Registering
Activating
Deactivating
Moving the software to a different PC
Making changes to your PC
Decommissioning a PC
Checking for updates

[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
¢ Activation problems

Installing the software

The latest version of Multi-Camera can be downloaded from www.breezesys.com.

To install Multi-Camera simply download and run the setup program then follow the on-screen
instructions.

Uninstalling the software

Multi-Camera can be uninstalled using the standard Windows "Uninstall a program" option in the
Programs section of the Windows Control Panel.

IMPORTANT: Please deactivate Multi-Camera before uninstalling otherwise you may not be able to
activate the software on another computer. If you forget to deactivate the software you should be able
to reinstall the software, deactivate it and then uninstall.

Evaluation Version

The trial evaluation version of the software is identical to the registered version and is fully functional
for 15 days. Each time you run the software it will display the registration dialog allowing you to enter a
registration code or press the "Evaluate” button to continue evaluating the software:
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DSLR. Remote Pro Multi-Camera v1.9 Registration M

Evaluation copy, 15 days remaining. Valid for up to 4 cameras
If you have already purchased DSLR Remote Pro Multi-Camera and have received your
registration details please enter them below and press the "Register” button,

Mame:

Registration code:

Press the "Buy Online® button to visit Breeze Systems website to purchase a copy of
DSLR Remote Pro Multi-Camera
Computer name: QUAD-I7

Help H Register ” Evaluate

At the end of the 15 day trial period you must purchase a license to continue using the software.

Registering the software

To purchase a license for Multi-Camera please visit our website: http://www.breezesys.com/
purchase_dslrrempro_mc.htm. You will be sent an email containing your registration details when your
order has been processed.

To register Multi-Camera run the application enter your registration name and code exactly as they
appear in your registration email. You may find it easier to copy and paste both the registration name
and code directly from your registration email to avoid mistakes when entering it. Please keep a copy
of your registration email safe in case you need to re-enter your registration details.
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m——————————
DSLR Remote Pro Multi-Camera v1.9 Registration [

Evaluation copy, 15 days remaining. Valid for up to 4 cameras
If you have already purchased DSLR Remote Pro Multi-Camera and have received your
registration details please enter them below and press the "Register” button,

Marne:
Chris Breeze

Reqgistration code:
O0OHEE-CIIB77-ROQOQUID-2BNZ50-WWNG40-3B QX T2-6GVVAL

Press the "Buy Online® button to visit Breeze Systems website to purchase a copy of
DSLR Remote Pro Multi-Camera
Computer name: QUAD-I7

Help ][ Register ” Evaluate

T

T

Click on the "Register" button after entering your name and registration details. If the details are
correct the message below will be displayed. An error message will be displayed if the name and
registration code are not valid (e.g. they were not entered correctly) or if you need to purchase an
upgrade to use this version of the software.

DSLR Remote Pro Multi-Cameravld e

Click on the "Yes" button to register the software and the following message will be displayed asking
you whether you want to activate the software on this computer:
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DSLR Remote Pro Multi-Camera v1.9 e s

" 1 Registration successful,

Do you wish to activate the license on this computer now?

Click on the "Yes" button to activate the software on this computer (see the section below for details).

Activating the software

The software must be activated on the computer before it can be used. The software can be run
without activating for up to 10 days after the the date when the registration code was issued. After that
time the software will not run unless it is activated. The software can only be activated on up to two
computers at any given time. If you wish to move the software to a different computer you must
deactivate it from the old computer before activating it on the new computer. Once the software has
been activated on a computer you can run it normally.

To activate the software click on the "Activate..." button in the registration dialog

g
DSLR Remote Pro Multi-Camera v1.9 Registration e 25 v

WARMIMG! This registration code must be activated before it can be used.

Press the “Activate”™ button to activate the software or press the "Exit” button to exit
software.

Alternatively enter a new registration code below and press the "Reaqister”™ button.

Mame:
Chris Breeze

Registration code:
O0OHEE-CIIB77-RQQUZD-2BNZ 50-WWYNE4D-ZBOQX 72-6GVVAA

AR

Press the "Buy Online™ button to visit Breeze Systems website to purchase a copy of
DSLR Remote Pro Multi-Camera
Computer name: QUAD-I7

Buy Online ” Activate... ] [ Help H Register ” Close

and the activation dialog below will be displayed:
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DSLR Remote Pro Multi-Camera Activate Online S

Activate Press the "Activate online” button to activate the software
Online anline {requires an internet connection).

Activate Press the “Activate by email” button to display details an
by email how to activate the software by email.

Close

The quickest and simplest way to activate the software is to do it online by pressing the "Activate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to activate the software online.

Please note that it may take up to 30 seconds to activate the software online.

If the computer is not connected to the internet you can activate the software by email by clicking on
"Activate by email" button and the dialog below will be displayed:

-~

D5LR Remote Pro Multi-Camera Activation

To activate the software by email please copy the text below into an email and send it to
sales@breezesys.com. When you receive your confirmation email enter the activation code below and
press the “Activate”™ button.

P

Copy text to dipboard ]

Activation code (HW fingerprint: 7887-B082):

[ Activate ][ Cancel

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
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have email you can copy the activation text to a USB memory stick and then read it on a computer
which does have email.

You should normally receive an email containing your activation code within 12 hours of sending the
activation request email. Paste your activation code into the "Activation code" text area at the bottom of
the activation dialog and click on the "Activate" button to activate the software. If you have closed the
activation dialog you can display it again by running the software and then clicking on the "Activate..."
button in the registration dialog followed by the "Activate by email" button.

Deactivating the software

The software can only be activated on up to two computers at any given time. If you wish to move the
software to a different computer you must deactivate it from the old computer before activating it on
the new computer.

You also need to deactivate the software before making any hardware changes, upgrading or
repairing the PC, reinstalling Windows or reformatting a hard disk. The software can then be
reactivated after the work has been done.

To deactivate the software select "Register..." from the Help menu in the main window to display the
registration dialog:

DSLR Remote Pro Multi-Camera v1.9 Registration [&J

DSLR Remote Pro Multi-Camera is registered and activated on this computer.
Press the "Close™ button to continue or the "Deactivate” button to deactivate the
software from this computer and move the license to a different computer.
Computer name: QUAD-IY

Marne:
Chris Breeze

Registration code:
O0OHEE-CIIB77-ROQOQU30-2BNZ50-WWNGS40-3B QX T 2-6GVVAA

Computer name: QUAD-I7

Buy Cnline I [Deactivate... I

Then click on the "Deactivate..." button to display the deactivation dialog:
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-

D5LR Remote Pro Multi- Camem Deactwate Cnline

o

Deactivate

Online

Deactivate
by email

Press the "Deactivate online” button to deactivate the
software online (requires an internet connection).

Press the "Deactivate by email” button to display details an
how to deactivate the software by email,

e P B B T B B W W W W

The quickest and simplest way to deactivate the software is to do it online by pressing the "Deactivate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to deactivate the software online.

Please note that it may take up to 30 seconds to deactivate the software online.

If the computer is not connected to the internet you can deactivate the software by email by clicking on
"Deactivate by email" button and the warning dialog below will be displayed:

-~

DSLR Remote Pro Multi-Camera

or

e

b WARNING: If you deactivate using the email cption you must email the
W deactivation information to sales@breezesys.com. You will only be able
to re-activate the software on this computer by using online activation

by asking for ancther activation code by email,

Are you sure you want to deactivate the software from this computer?
Mo

I ves H

D O L O Gy e P P R e T 3 TR N U ey S AL N A P

Click on the "Yes" button if you want to continue and the deactivation dialog below will be displayed:
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D5LR Remote Pro Multi-Camera Deactivation &J

This computer has been deactivated.
Please copy the text below into an email and send it to sales@breezesys.com.

Copy text to dipboard

HW fingerprint: 7887-BD&2

Close

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the text to a USB memory stick and then read it on a computer which does
have email.

You should normally receive an email acknowledging the deactivation code within 12 hours of sending
the request email. If you forget to copy the deactivation information and email it to sales@breezesys.
com you can display it again by selecting "Register..." from the Help menu in the main window and
clicking on the "Display" button. Please note that the copy of the deactivation information will be not be
available after another registration code has been entered.

Moving the software to a different PC

The software can be activated on up to two computers at any given time and so if you are moving the
software to a different PC you should deactivate the software from the old PC first. Then install the
software on the new PC, then register and activate the software.

If you are planning to move the software to a different PC permanently please following the instructions
for decommissioning a PC.

Making changes to your PC

You need to deactivate the software before making changes to your PC such as upgrading the PC
hardware, reformatting a hard disk, reinstalling Windows, upgrading Windows or getting a PC
repaired.
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Simply deactivate the software online (or by email if the PC doesn't have access to the internet), make
the changes and then re-activate the software. If Windows has been reinstalled or the hard disk has
been replaced or reformatted you may need to re-install Multi-Camera, re-enter your name and
registration code and then activate the software.

The latest release and previous releases of the software can be downloaded from the upgrades page
on the Breeze Systems website.

IMPORTANT: Please make sure you have a copy of your name and registration code before making
changes to your PC just in case you need to re-enter them later

Decommissioning a PC

If you are decommissioning a PC and planning to sell it or give it to somebody else you need to
deactivate the software and remove your registration details. It is very important that you remove your
registration details even if you have uninstalled the software otherwise the new owner may be able to
reinstall the software and gain access to your registration details. If someone obtains your registration
details they will be able to register and activate the software on their computer and could prevent you
from using it on your computer.

After deactivating the software you can remove your registration details by entering the special
registration code below:

Name: Uninstall
Code: N5BVJG-YBJEYC-ZDP6T4-P0ZGYH-HT68MU-KODT2N-QTONBP

This will install a special old code which replaces your registration details and will cause the software
to display an "Upgrade required" message when it is run.

If you decide to use the computer again you can reinstall the software, enter your registration details
and activate software.

Checking for updates

You can check for updates by selecting "Check for updates online". This will connect to the internet
and display details of the latest version of Multi-Camera in your web browser. Alternatively go to the
Multi-Camera page on our website: http://www.breezesys.com/MultiCamera

Activation problems

If the error message "The server name or address could not be resolved" is displayed when you try to
activate or deactivate the software online it means that the PC is unable to access the internet. Please
check that that the computer is connected to the internet and check your firewall settings to make sure
that DSLRRemote.exe (the Multi-Camera program) is allowed to access the internet. If you are still
unable to activate the software online you may need to activate it by email instead.

If a different error message is displayed please follow the instructions displayed in the error message.
If you are not sure what to do please email sales@breezesys.com and include your registration name
and code and details of the error message.

Please also see the support page on the Breeze Systems website for help with activation problems.
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3.1

Main Window

The Main Window

The main window shows the main camera controls together with a large preview
display and a histogram for assessing exposure. The main camera settings can be
changed using the controls down the left hand side of the main window. Other
settings are available from the menus.
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Shitter release: AF

BE lock button: AE lock
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| ¢-Prw]nmj |Hacst]mug:-“-' ]
RigE: 229,273,226

Image downloadad - &se: @ F16.0, [50 200
Screen shot of Multi-Camera main window showing optional focus point overlay
display

Release and Preview Buttons

Release Button

Click on the Release button (or press F8) to take a picture. The picture is
automatically downloaded to the PC, displayed in the main window and saved to
disk. Images can be stored on the PC's hard disk, on the camera's memory card or
both. When Multi-Camera is run it always defaults to saving images to the PC only.
Please select the appropriate option from the "Camera" menu if you wish to use a
different setting.
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Note: No picture is taken if the camera is set to auto-focus and is unable to focus.

Preview Button

Click on the Preview button (or press F9) to take a picture in preview mode. The
picture is taken as a small JPEG with normal quality so that it is downloaded to the
PC quickly. The picture is not stored on the PC's disk or the camera's CF card.

3.2 Reviewing and deleting images

Reviewing Previous Images

You may review previous shots by pressing the "<- Prev Image" and "Next Image ->
buttons or by using the left and right cursor keys. The main and preview images
displays are updated to display the selected image together with the histogram
display. You can delete previously taken shots in the normal way. To help identify
which shot is being displayed the status bar shows the filename of the image and its
number in the sequence e.g. [3 of 5].

When a picture is taken the display is updated to show the new shot.
Deleting Images

Press the Delete key to delete the current picture. If the picture was saved to disk it
is deleted from the disk and removed from the display.
Note: Pictures saved to the CF card are not deleted.

3.3 Changing camera settings

Changing Camera Settings

The camera settings can be changed using the controls in the main window or
directly using the camera's controls. When the settings are changed on the camera
they are updated and displayed in the main window. Not all controls can be changed
in all camera modes (e.g. the shutter speed can only be set in Manual and Tv
exposure modes) and so some controls are "grayed out" when they are not
applicable.

Operation is more reliable if "Ignore camera updates" is selected from the Camera
menu when taking pictures using the camera's controls. When this is selected the
settings shown in the main window display are not updated to reflect changes in the
camera's setting. You can update the settings display by pressing F5.

Notes
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3.4

. The lens can only be zoomed by physically turning the zoom ring on the lens
. Depending on the camera model the focal length display may not be updated

in the main window until the next picture is taken

. You can only switch between manual and autofocus using the switch on the

lens

. There is no way to take a exposure reading and display it in the main window

without taking a test shot

. The exposure mode for the EOS-1D series cameras can be set from the PC.

For other camera models it can only be selected by turning the mode dial on
the camera

. The flash exposure compensation, drive mode and AF mode can only be set

using the camera controls when using a Canon EOS-1D and 1DS (also Kelvin
color temperature for the EOS-1D). This is a limitation of the cameras' firmware
and may be adjustable from the PC in a future release if Canon release new
firmware.

Full screen mode

Full Screen Mode

Press F11 or select "Full Screen" from the view menu to display images in full screen
mode. Press the Escape key or F11 to exit full screen mode.

In full screen mode the images fill the screen. The following keyboard short cuts are
available when in full screen mode:

F7 View image

F8 Release the shutter and save the image
F9 Take preview shot

F11/Esc Exit full screen mode

Delete Delete current image

Cursor left Display previous image

Cursor right Display next image

Ctri+C Toggle caption display on and off
Ctrl+F lf?cggle focus point overlay display on and
Ctrl+G Toggle grid overlay display on and off
Ctrl+W Toggle black and white display mode on

and off
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3.5

3.6

Bulb Mode and Mirror Lockup

Bulb Mode and Mirror Lockup

It is not possible to use bulb mode when triggering the shutter release from the PC.
This is a limitation of the camera not Multi-Camera. Pictures can still be taken in bulb
mode by pressing the camera's shutter release button.

Mirror lockup can be used with all cameras that support mirror lockup if the picture is
taken by pressing the camera's shutter release or by using a remote release cable.
Some older cameras (e.g. Canon EOS 10D) can use mirror lockup and be triggered
from the PC. With these cameras the mirror will flip up and the picture will be taken
after a 2 second delay.

Auto Bracketing

Auto Bracketing

Multi-Camera has flexible settings for auto bracketing (taking a sequence of shots
using different exposure settings) which simplify the taking of shots which are later
combined together to form a single HDR (high dynamic range) image. To enable
auto bracketing select the "Auto-bracket" checkbox and then click on the "Settings...'
button to display the auto bracket settings dialog below:

Auto Bracket Settings @

Mumber of shots in sequence: | 3 »

Skops separating each shot: | 2 skop W

(1/Z stop will be used when camera is set to 1§2 stop exposure increments and
13 or 2/3 is selected above)

The exposure will be adjusted by changing the exposure compensation value
unless the camera is set ko manual expasure inowhich case either the aperture
ar the shutter speed will be adjusted.

Please note; The settings above may be adjusted if they exceed the range of
settable exposure compensation values.

Setting to madify when camera is set ko manual exposure:
(%) Shutter speed

) Aperture

Execute command at end of auto bracket sequence

Crnd: | photomatix, bat

Ik l [ Zancel
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You can set the number of shots in the sequence using the first dropdown list. Then
set the number of exposure stops should separate each shot. This can be 1/3, 2/3,
1,11/3,12/3,2,21/3,22/3, 3, 3 1/3, 3 2/3 or 4 stop per shot depending on your
camera's settings (if your camera is set to use 1/2 stop increments instead of 1/3
stop increments selecting a value of 1/3 or 2/3 stop increments will result in 1/2 stop
increments being used).

The different exposures are set using the camera's exposure compensation control if
the one of the auto exposure modes is selected. If manual exposure mode is
selected the exposure will be varied using either the shutter speed or the aperture
according to the settings in this dialog. Normally it is better to keep the aperture
constant (and hence the depth of field) and vary the shutter speed.

Multi-Camera can optionally run a command at the end of the auto bracket sequence
to combine the shots. To do this click on the "Execute command at end of auto
bracket sequence" checkbox and enter the name of the program or script to run. In
the screenshot above the script "photomatix.bat" has been entered. This will run the
Windows batch file "photomatix.bat" which combines the images using Photomatix
Pro (which can be purchased from http://www.hdrsoft.com) and displays the result in
BreezeBrowser Pro (http://www.breezesys.com/BreezeBrowser ). The batch file can
be found in the Multi-Camera installation folder (usually C:\Program
Files\Breezesys\Multi-Camera) and makes use of the command line interface for
Photomatix Pro. Please see the batch file for details.

Suggested procedure for auto bracketing:

1. Use a tripod and compose the shot as required

2. Switch to manual exposure mode and low ISO setting to maximize the quality

3. Set the required aperture (e.g. use a small aperture like f/16 for good depth of
field)

4. Take a preview shot to determine the correct exposure (this can be judged by
looking at the histogram display). It may be necessary to take a number of test
shots to get the correct exposure. Adjust the exposure by changing the shutter
speed

5. Set the lens to manual focus and focus carefully

6. Set the required number of shots and number of stops separating each shot (a
5 shot sequence with 1 stop increments is a good start, more shots may be
required if the brightness range in the shot is very large)

7. Press the "Release" button and Multi-Camera will automatically take the
sequence

Auto exposure bracketing is particularly useful for product shots and for taking
pictures of the interiors of buildings. The photos below compare the results from a
single exposure of the interior of a church with an image which was blended from
seven separate exposures taken using DSLR Remote Pro's auto bracketing feature:
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Single exposure ' Z__ - Blended exposure

Photo of the interior of St Andrews Church Sherborne St John, Hampshire, England.
(The image on the right was created by blending the auto bracketed images using a
separate image editor which is not part of Multi-Camera)

The seven shot auto bracket sequence used to create the blended exposure above:

TR

Please Note: Multi-Camera doesn't support auto bracketing with multiple cameras
when shooting in raw+JPEG mode.

3.7 Grid and focus point overlays
Grid Display
To toggle the grid overlay on the preview image type Ctrl+G or select "Display Grid" from the "View"

menu. Select "Grid Settings..." from the "View" menu to display the "Grid Settings" dialog, shown
below:
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3.8

3.9

Grid Settings X

Mumber of haorizantal divisions: | 3

4F 4

Mumber of vertical divisions: 3

Display area for print size
Print aspect ratio (e.g. 10x8): | 5 x |7

Line color; 1 [:]

[ ]Enable grid display

l Ok l [ Cancel

Select the show print area checkbox to show the extent of a particular print size. For example most
digital SLRs shoot images with an aspect ratio of 3:1 which fits perfectly on a 6"x4" print but needs to
be cropped if it is printed on 10"x8" paper. You can display extent of a 10"x8" print by setting the print
aspect ratio to 10 x 8.

NOTE: The grid display is only displayed on the preview image and doesn't affect images saved to
disk.

Focus Point Overlay Display
To toggle the focus point overlay display type Ctrl+F or click on the "Display overlay" checkbox. When
the focus point overlay display is enabled the seven focus point areas and the viewfinder circle are

displayed over the preview image. Active focus points are displayed in red.

NOTE: The focus point overlay display is only displayed on the preview image and doesn't affect
images saved to disk.

Flashing highlight display

Flashing Highlight Display

Select "Flashing Highlights" from the "View" menu to display over-exposed areas by highlighting them
flashing on and off in black. The method of calculating the highlight values and the threshold at which
to start flashing them can be specified by selecting "Highlight Settings..." from the "View" menu. When
the highlight method is set to "Luminosity" the luminosity or brightness of the image is used to
calculate the highlight values. When it is set to "RGB value" the largest of the red, green and blue
channel values is used.

NOTE: The flashing highlight display is only available for images displayed in the main window. It is not
available in full screen mode or the image preview window.

Screen blanking

Blanking the Screen

To avoid extraneous light from the computer display affecting the lighting setup the screen can be
blanked when taking a photo. To do this click on the "Camera" menu and select "Blank screen when
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taking photo". When this option is selected the screen will be automatically blanked when the shutter is
released from the PC. The screen will be restored after the camera has finished taking the picture. The
screen may also be restored by clicking the left mouse button.

3.10 Editing Images and Editor Setup
Editing Images and Editor Setup
Right click on the image and select "Edit Image" to open the image in an image editor (or press F3).

For this feature to work you need to tell Multi-Camera how to run the image editor by selecting "Setup
Image Editor" from the File menu.

Editor Setup @

{1 Use the Windows Explorer 'Open’ command
{*) Use the command line below:

Z:AProgram Files\adobel Photoshop CSYPhotoshop, exe B

[ ] automatically edit the image when a phota is taken

Select the "Use the Windows Explorer 'Open' command" option to use the same editor or viewer as
when you open or double-click an image in Windows Explorer.

Select the other option and enter the command line in the edit box to specify a different editor.

Select "Automatically edit image when a photo is taken" to automatically load images into an editor
when they are taken. Please take care not to load too many images into your editor as Windows may
run low on memory causing the editor or Multi-Camera to fail.

NOTES:

1. Only images saved to disk can be edited. Preview images cannot be edited.

2. Most image editors cannot open Canon raw files directly and will display an error message if you try
to edit a raw image.

3.11 Displaying Images in BreezeBrowser Pro
Images can be automatically displayed in BreezeBrowser Pro after they have been taken and

downloaded to the PC. To do this select "Setup image editor..." from the File menu and set it up to run
the command BBProDisplay.exe as shown below:
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Editor Setup f5__<

{1 Use the Windows Explorer 'Open’ command
(%) Use the command line below:

BEProDisplay, exe E]

Automatically edit the image when a photo is taken

3.12 Adding comments and IPTC data
Adding Comments

Comments can be automatically added to images as they are taken by entering the comment text in
the edit box located above the histogram.

Comments may be edited in existing images by right clicking on the image and selecting "Edit
comments..." from the menu. Comments can only be edited in images that have been saved to the
computer's disk.

Adding IPTC Data

Multi-Camera can be setup to automatically store IPTC data in raw and JPEG images as they are
taken (this option is only available when saving images to the PC's hard disk). Select "Add IPTC data
to images" from the "File" menu to enable this function. The IPTC data to be stored in the image may
be edited by selecting "Edit IPTC..." from the "File" menu and the dialog below will be displayed:
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NAAJIPTC Data

X

Caption | Keywords | Categories | Credits/Skakus | Origin

CObject Mame: | %o

Date Created: | ¥Y9%maLD Time Created: | ¥HY¥%M¥3%2
Release Date: Release Time:

Ciky: Mew York

Sublocation: Manhattan

Skate/Province: | MY

Counkry: United States Country Code: | USA

Criginal Transmission Reference;

Load From file... ] [ Save ko file. .. ] [ (04 ] [ Zancel

Click on the tabs along the top of the dialog to select the different IPTC data types. Settings may be
saved for future use by pressing the "Save to file..." button and loaded using the "Load from file..."
button.

IPTC data can be entered as normal text or as special tokens which are evaluated when the photo is
taken e.g. %Y for the year. Please see the IPTC tokens page for a list of the available tokens.

3.13 The Image Preview Window

To display an enlarged preview window select View Image from the Image menu (or press F7). The
image preview window can be left on the screen while more pictures are taken to monitor composition
or focus in critical areas e.g. the eyes of a model during a portrait session. The preview window is
automatically updated when the image in the main window changes.

The image can be scrolled by moving the scroll bars or by clicking the left button on the mouse and
dragging the image. If the image preview window is still displayed when a picture is taken it will be
updated to show the same area of the new shot. This is very useful for monitoring important areas of
the image e.g. a model's eyes when taking portraits.

When shooting JPEG images the preview is the same size as the final image. To avoid a lengthy delay
converting raw images the embedded JPEG is displayed (cameras that shoot CRW raw files) or the
associated JPEG when shooting in raw+JPEG mode with the EOS-1D and 1DS. The size of the
embedded JPEG for Canon EOS 10D raw files is set using the RAW+JPEG custom function (CFn 8).

NOTE: No image is displayed in the Image preview window when shooting in raw mode with an EOS-
1D or 1DS. This is because the raw file only contains a small preview image. Please select
Raw+JPEG mode if you wish to display images in this window.
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3.14

3.15

3.16

3.17

Auto Reconnect

When auto reconnect is selected from the "Camera" menu Multi-Camera will attempt to reconnect to
the camera every 5 secs if it becomes disconnected. DSLR Remote will display a red screen saying
"Not connected" to clearly indicate that the connection has been lost.

The connection to the camera will be lost if the USB cable is removed, the CF card door is opened, the
camera is switched off or the battery becomes flat or is removed.

Warning: Do not disconnect the camera from the computer while images are being downloaded. This
may result in some images being lost and may confuse the USB or FireWire drivers making it
necessary to reboot the PC before reconnecting.

When auto-reconnect is selected any modal error dialogs that are displayed to report errors will
automatically cancel after 10 seconds.

Suppress Image Display

Select this option from the "View" menu if you do not need the images to be displayed on the PC.
Selecting this option gives a slight improvement in the download speed when shooting multiple
pictures. This is useful if the pictures are being captured to the PC and then forwarded to some other
system e.g. by FTP to a picture desk.

New SubFolder

Select File->New Subfolder to quickly create a new subfolder using the current date and time. This is
useful when taking pictures with multiple cameras when you want each new set of pictures to be
stored in a new folder.

Download Photos

The "Download Photos" dialog can be used to download photos stored on the cameras' memory cards
to the PC. This option is useful if the software has been setup to save the photos to the cameras'
memory cards only. The "Download Photos" dialog can be displayed by selecting "Download Photos..."
from the "Camera" menu or by typing the keyboard shortcut Ctrl+D:
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”
¥ | Download Photos ﬁ

1 cameras, 1 with memory cards

Delete files from memaory cards after downloading

Downloading photos from camera 1 of 1...

Downloaded: IMG_0021.CR2 (24.9MB) as C:\DSLRRemote\2015-06-24\7500_0003.CR2
Downloaded: IMG_0021.JPG {4,724KE) as C:\DSLRRemote!2015-05-24\7600_0003.IPG
Downloaded: IMG_0022.CR2 (24.9MB) as C:\DSLRRemote\2015-06-24\7500_0004.CR2
Downloaded: IMG_0022. PG {4, 742KB) as C:\DSLRRemaote!2015-06-24\7600_0004. PG
Downloaded: IMG_0023.CR2 (24.5MB) as C:\DSLRRemote\2015-06-24\7500_0005.CR2
Downloaded: IMG_0023.JPG {4, 725¢B) as C:\DSLRRemote|2015-06-24\7600_0005.JFG
Deleting files from memaory card...

Deleted: IMG_0023.JPG

Deleted: IMG_0023.CR2

Deleted: IMG_0022,IPG

Deleted: IMG_0022.CR2

Deleted: IMG_0021.IPG

Deleted: IMG_0021.CR.2

annluadini cnmi eted
& files downloaded: 3 CR.2 raw files and 3 JPEGs

Download

Set the "Delete files from memory cards after downloading” if you want to delete the files from the
cameras' memory cards. Then click on the "Download" button to download raw files and JPEGs from
the cameras' memory cards. The downloaded files will be downloaded with the filenames specified in
in Preferences.

Please take care when shooting raw+JPEG and using the option to download the JPEGs to the PC at
the time of shooting. The JPEGs that have already been downloaded my affect the filenames used for
the raw+JPEG pairs when they are later downloaded using the "Download Photos" dialog. To avoid
problems with confusing filenames caused by JPEGs already in the download folder it is best to move
or delete the JPEGs before downloading the raw+JPEG files or to select an empty folder before
downloading.

4 Multi-camera Operation

Multi-Camera can control one or more Canon DSLRs connected to a single PC or a group of PCs
networked together.

The maximum number of cameras that can be controlled is determined by the license purchased for
the software. This can be displayed by selecting "About Multi-Camera" from the Help menu. The
default evaluation license will allow up to four cameras to be controlled during the evaluation period.

Please see the preferences section for information on how to synchronize multiple copies of DSLR
Remote Pro via a network.

Trlggerlng Cameras

Multiple cameras connected a single computer can be triggered via the USB connection to each
camera but there will be a delay of approximately 1/10 second between each camera taking a photo.
For larger arrays of cameras and more accurate synchronization (to within a few milliseconds) it is
necessary to trigger the cameras via their remote release sockets. Please see this page on the Breeze
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Systems' website for more information.
Please see this section for information on triggering cameras using an ESPER TriggerBox

Auto Barcode Reader Mode

Auto barcode reader mode provides a way to automatically trigger the cameras when a barcode is
scanned using a barcode reader. The barcode is copied into the comments field in the main window
and the "Release" button is pressed to trigger the cameras. The contents of the comments field can be
included in the filenames of the downloaded photos by selecting the "Prefix filename with comment
string" option in File->Preferences or by using the {comment} token in the "Filename prefix:" field. The
barcode can also be used to specify the download folder by adding the {comment} token to the
"Directory in which to save images".

Auto barcode reader mode can be enabled or disabled by typing Shift+Ctrl+b.

Please note that auto bar code reader mode is intended for multi-camera inspection systems and isn't
suitable for event shooting because it triggers the cameras via USB which results in the cameras being
triggered with a delay of approximately 1/10 sec between each camera.

Photo Booth Mode

Run a multi-camera rig like a photo booth with live view display and a countdown before taking the
photos.

Camera rear LCD blanking workaround

Some Canon camera models (e.g. Canon EOS 100D/Rebel SL1) turn the rear LCD off after 30
minutes of inactivity which can be annoying if you want to leave it on all the time to provide a quick
visual check of the camera status. Multi-Camera has a workaround which reads and writes the
camera's ISO setting to reset the camera's inactivity timer. This can be enabled by exiting Multi-
Camera and setting the following DWORD value in the Windows registry:
HKEY_CURRENT_USER\Software\BreezeSystems\DSLRRemoteProMulti\100\IsoKickPollingInterval

This setting specifies the interval in seconds between reading and writing the camera's ISO setting to
prevent the camera from turning the rear LCD off. Affected camera models turn the rear LCD off after
30 minutes of inactivity and the suggested setting for this value is 1700 seconds. Set
IsoKickPollingInterval to 0 to disable it.

Connecting to Multiple Cameras

Single copy of Multi-Camera controlling multiple cameras on a
single PC

This is the recommended configuration for small to medium sized arrays of up to 32 cameras.
Connect the cameras to the PC using USB cables and turn them on before running Multi-Camera.
Multi-Camera will automatically connected to all the cameras (or to the maximum number of cameras
allowed with your license). It may take several seconds to connect to each camera when a large
number of cameras are used. After connecting to the cameras Multi-Camera will sort them using the
author string followed by the camera serial number. This ensures that the cameras will always be
numbered in a repeatable manner. You can edit the author string stored in the camera by selecting
"Edit camera id" from the Camera menu.

Individual cameras can be selected using the "Camera:" drop down list which can be found below the
release and Preview buttons in the main window. If the "Gang camera settings together" option is
selected in preferences changes to the camera settings made via the controls in the main window (e.g.
shutter speed, aperture, ISO, white balance) will be applied to all connected cameras.
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D5LR Remaote Pro Multi-Camera Preferences Iﬁ

Mouse button actions

Middle button: | Mone v] Right button:

Gang camera shutter releases together, delay inms: 0
Gang camera settings together [ Sort cameras by Author
[] synchronize multiple copies of DSLR. Remote Pro Multi-Camera:

Saved image settings |

[ Prefix flename with comment string || Lower case file extensions
[] Append sequence letter to end of filenames when auto-bracketing
|:| Sort images into groups !

Filename prefix: %90 Digits: 4

Directory in which to save images:

C:\DSLRRemote B
Separate directory for: [¥f] Year Manth Day i
Flatten date (e.g. 2012-02-24)

Sub-folder: !

Example image name:
C:\DSLRRemote}2014-04-08410001_0123.JPG

| 0K I [ Cancel ]

SE———————

Auto Reconnect

If the "Auto Reconnect" option is selected in the "Camera" menu DSLR Remote Pro will automatically
connect to new cameras as they are detected or disconnect from a camera if it goes offline (e.g. it is
turned off or the USB cable is unplugged).

Single copy of Multi-Camera controlling multiple cameras on
multiple PCs

This is the recommended configuration for medium to large arrays (32 cameras or more). Running the
software on multiple computers will reduce the time it takes to download the photos from all the
cameras.

This is similar to the "Single copy of Multi-Camera controlling multiple cameras on a single PC"
configuration described above but uses a shared folder to synchronize the camera settings. When the
camera settings are changed using the controls in the main Multi-Camera window the settings are
saved to a file named settings.xml in the shared folder. Copies of Multi-Camera running on other
computers on the network will monitor the settings.xml file and apply the changes to the cameras
connected to that PC. This allows the settings for all cameras to be adjusted using any PC on the
network.
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D5LR Remote Pro Multi-Camera Preferences @

Mouse button actions

Middle button: | None v] Right button:

Gang camera shutter releases together, delayinms: 0

Gang camera settings together [ | Sort cameras by Author

Synchronize multiple copies of DSLR. Remote Pro Multi-Camera:
Directory:  YWyServershared_folder E]

Saved image settings

[| Prefix flename with comment string [ | Lower case file extensions
[] Append sequence letter to end of filenames when auto-bracketing
|:| Sort images into groups

Filename prefix: %60 Digits: 2

Directory in which to save images:
C:\DSLRRemote B

Separate directory for: [¥] Year Manth Day
Flatten date (e.g. 2012-02-24)
Sub-folder:

Example image name:
C:\DSLRRemote20 14-04-084100D1_0123.IPG

Multiple copies of Multi-Camera each controlling a single camera

Multi-Camera can also run in a special "single camera per instance" mode where each copy of the
software only controls one camera. Multiple cameras can be controlled by running multiple copies of
Multi-Camera on the same PC. This has the advantage that each copy of Multi-Camera only connects
to one camera and the other cameras are not affected if that camera goes offline for any reason (e.qg. it
is turned off, the battery runs out or the USB cable is disconnected). You can also use the "Auto
Reconnect" option in the "Camera" menu so that Multi-Camera automatically reconnects to the camera
when it comes back online. The main disadvantages of using this mode are that it is slightly more
difficult to setup and it requires a more powerful PC than using a single copy of Multi-Camera to control
multiple cameras.

An AutoHotKey script called DsIrRemoteProMultiCamera.ahk is provided to help with running multiple
copies of Multi-Camera. Before using it please install AutoHotKey (this is a free download from www.
autohotkey.org). Then connect all the cameras, turn them on and wait for Windows to detect them all.
Then double click on the DsIrRemoteProMultiCamera.ahk script to run it. This will run a utility called
ConnectedCameralList.exe which displays a list of the connected cameras and the USB ports they are
connected to. The script reads this list and then launches a copy of Multi-Camera for each camera.
The script then arranges the Multi-Camera windows on the screen and displays a small summary
window at the top of the screen. Closing the summary window will also close all the Multi-Camera
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windows.

Please note: The DsIrRemoteProMultiCamera.ahk script is provided "as is" for your convenience and
we do not offer support in debugging or modifying it. You are free to modify it to suit your needs or we
can do this for you at our normal consultancy rate.

The settings on the cameras can be changed using a single copy of Multi-Camera by using the
"Synchronize multiple copies of Multi-Camera" option. The shared folder doesn't need to be a folder
shared on the network if only one PC is being used to control the cameras.

Multiple copies of Multi-Camera each controlling a single camera
on multiple PCs

This is similar to the "Multiple copies of Multi-Camera each controlling a single camera" configuration
described above but uses a shared folder to synchronize the camera settings. When the camera
settings are changed using the controls in the main Multi-Camera window the settings are saved to a
file named status.xml in the shared folder. Copies of Multi-Camera running on this computer and other
computers on the network will monitor the status.xml file and apply the changes to the cameras
connected to that PC. This allows the settings for all cameras to be adjusted using any PC on the
network.

4.2 Changing Camera Settings

Camera settings can be changed by using the camera controls on the individual cameras or by using
the control in the main window. When a setting is changed using an individual camera's controls only
that camera's settings are changed. If the controls in the main window are used to change the settings
and the "Gang camera settings together" option in preferences is selected the same settings will be
applied to all cameras. The settings for the current camera can be applied to the other cameras by
selecting "Sync camera settings" from the Camera menu.

A table summarizing the main settings for each camera can be displayed by selecting "Show Camera
Status" from the Camera window. This window will also report any cameras which are set to different
exposure modes or AF settings.

4.3 Taking Photos

Taking Photos from the PC

Press the "Preview" button in the main window to take a photo with the current camera which is
displayed but is not saved.

Press the "Release" button to take a photo which is saved to the PC's hard disk or the camera's
memory card. This will take a picture with the current camera only unless "Gang camera shutter
releases together is set in preferences. When this option is set Multi-Camera will send release
instructions to all connected cameras in succession as quickly as possible. There will be a delay of
approximately 1/6 sec between the firing of each camera and so this option is only really suitable for
static subjects.

You can also use the following keyboard shortcuts to take photos:

F8 - take photo with the current selected camera and all connected cameras if the "Gang camera
shutter releases together" option is selected

Shift+F8 - take photo with only the currently selected camera

F9 - take preview photo with the currently selected camera (same as Shift+F8 except that the photos is
not saved)

Taking Photos from the Camera

Press the shutter release on one of the connected cameras to take a photo with that camera only. This
method is useful when aligning and focusing an array of cameras as you can quickly press the shutter
release for a given camera, view the image in the main window, adjust the camera position or focus
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4.5

and repeat the process.

Using the Camera Remote Release Socket

Pictures can also be taken using a remote shutter release plugged in to the side of the camera. By
wiring together remote shutter releases connected to each camera it is possible to trigger all cameras
simultaneously. This method of triggering the cameras is recommended if the subject is moving.
Please see this page on our website for more information.

Please note: There will be slight variations in the when each camera fires due to the shutter release
lag which will vary from camera to camera. This can be reduced by using mirror lockup on the
cameras.

It is advisable to set the camera lenses to manual focus before triggering the cameras simultaneously
otherwise each camera may take a different amount of time to auto focus before taking the picture.

Preview Options

The preview display in the main window is normally resized to fill the available viewing area. This can
be changed so that just the central portion of the image is displayed at 1x, 2x, 4x or 8x magnification to
aid accurate camera alignment and focusing. The display can be zoomed using in using the cursor up
button and zoomed out using the cursor down button. The magnification factor is displayed in the
bottom right hand corner of the image. Pressing the "Home" key will zoom out and display an image
that fits the display area. Pressing the "End" key will zoom in to 8x magnification.

A cross hair overlay can also be displayed by selecting "Display overlay" from the View menu. This
overlays a cross hair and circle to help highlight the center of the image.

Suggested File Naming Scheme

It is recommended that each camera is identified by setting a number in the camera author string. This
can be done by selecting each camera in turn using the "Camera:" drop down list and then selecting
"Edit Camera Id..." from the Camera menu. The author string is stored in the camera even when it is
turned off and so it only needs to be set once. Some cameras will only save the author string if they
are turned off using the power switch on the camera. The setting may not be saved if the cameras are
powered using external power adapters and the power is turned off.

e.g. If there are 12 cameras being used the cameras could be numbered 01, 02, 03, 04, 05, 06, 07, 08,
09, 10, 11,12

In Preferences set the filename prefix to {author}_. This will result in each image filename being
prefixed with the camera author string.

e.g. With 4 cameras with author strings set to 01, 02, 03 and 04 the downloaded images would have
the names like:

01_0001.JPG, 02_0001.JPG, 03_0001.JPG, 04_0001.JPG (first shot in the directory)
01_0002.JPG, 02_0002.JPG, 03_0002.JPG, 04_0002.JPG (second shot in the directory)

The image number can be placed at the start of the filename by using the %# token. This is useful if
more than one shot from each camera is saved to the same directory as it means that sorting images
into alphabetical order will give the order in which the pictures were taken.

e.g. With 4 cameras with author strings set to 01, 02, 03 and 04 setting the prefix to %# _{author}
would result in names like:

0001_01.JPG, 0001_02.JPG, 0001_03.JPG, 0001_04.JPG (first set of shots in the directory)
0002_01.JPG, 0002_02.JPG, 0002_03.JPG, 0002_04.JPG (second set of shots in the directory)

Sorted alphabetically this gives:

0001_01.JPG (camera #01, image #1)
0001_02.JPG (camera #02, image #1)
0001_03.JPG (camera #03, image #1)
0001_04.JPG (camera #04, image #1)
0002_01.JPG (camera #01, image #2)
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0002_02.JPG (camera #02, image #2)
0002_03.JPG (camera #03, image #2)
0002_04.JPG (camera #04, image #2)

The comment string entered in the main window can be added to the filename. This can be done
either by selecting the option to prefix the flename with the comment string in preferences or by using
the {comment} token when specifying the filename prefix. This is useful for product photography when
the product part number is entered in the comment field.

Owner, Author and Copyright strings

Newer camera models allow strings for the owner, author and copyright information to be stored in the
camera and written to the shooting data in JPEG and raw files. The author and copyright strings can
be set using the normal camera controls (please see the camera manual for details). Alternatively the
owner, author and copyright strings can be set for each camera in turn using camera drop down list in
the main window and then selecting "Edit Camera Id..." from the "Camera" menu:

Camera Cwner String &J

Camera serial number: 023011001285

Owner string: 001

Author: bankid1

Copyright Copyright 2011, Chris Breeze

(n]4 ] [ Cancel

The owner, author and copyright strings can accessed using the {owner}, {author} and {copy} tokens
respectively when specifying the filename prefix and download directory.

For example if you have several cameras arranged in different groups and wish to download the
images from each group to different folders you might set the download directory to "C:
\Photos\{author}"

and the filename prefix to "{owner}_":
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D5LR Remote Pro Multi-Camera Preferences M

Mouse button actions
Middle button:| None v] Right button:

Gang camera shutter releases together, delayinms: 0
5ang camera settings together || Sort cameras by Author
[ synchronize multiple copies of DSLR. Remote Pro Multi-Camera:

Saved image settings
[ Prefix filename with comment string [ Lower case file extensions

[] Append sequence letter to end of filenames when auto-bradketing
Sort images into groups

Filename prefix: | {fowner} Digits: 4

Directory in which to save images:
C:\Photos\{author} [E

Separate directory for: [ Year [ Month [ pay
[|Flatten date {e.q. 2012-02-24)

Sub-folder:

Example image name:
C:'\Photos{author H{owner}0123. PG

The author string can also be used for naming the photos from each camera. This is more convenient
than using the camera owner string because you can edit the author string using the camera controls
when the camera is not connected to a computer or from the computer (by selecting Camera->Edit
camera id...). The camera owner string can only be edited by connecting the camera to a computer. To
use the author string to name the photos set the "Sort cameras by Author" setting in preferences so

that the dropdown list of cameras in the main window is sorted by author string not owner string. Then
set the filename prefix to {author}_
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D5LR Remaote Pro Multi-Camera Preferences w

Mouse button actions

Middle button:[Nune v] Right button:

ang camera shutter releases together, delayinms: 0
Gang camera settings together Sort cameras by Author
[ | synchronize multiple copies of DSLR. Remote Pro Multi-Camera:

Saved image settings

[| Prefix flename with comment string [ | Lower case file extensions
[ Append zequence letter to end of filenames when auto-bracketing
|:| Sort images into groups

Filename prefix: {author}_ Digits: 4
Directory in which to save images:

C:'\Photos E]

Separate directory for: Year Manth Day
Flatten date (e.q. 2012-02-24)
Sub-folder:

Example image name:
C:\Photos'2014-04-09 author}_0123.1PG

4.6 View Sequence

This option displays a slideshow of all the images in a folder and is useful for checking camera
alignment.

All the images in a folder can be displayed as a slideshow by selecting View Sequence from the View
menu. This loads all the images in the current download folder, sorts them into alphabetical order and
then repeatedly plays them from start to end then back to the start again. e.g. if there are 4 images in
the folder it displays them in the order 1, 2, 3,4, 3,2,1,2,3,4, 3,2, 1....

The display order can be changed to "circle" (e.g. 1, 2, 3, 4, 1, 2, 3, 4...) by typing Ctrl+C or back to
"ping-pong" (e.g9. 1,2, 3,4,3,2,1,2,3,4, 3,2,1....) by typing Ctrl+P.

The speed of playback can be changed using the cursor keys: cursor up to speed up and cursor down
to slow down.

Type Ctrl+O to open a new folder of images and display them in sequence.
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4.7

4.8

Multi Live View and Multi-View

Multi Live View

Select "Multi Live View" from the "Camera" menu to display a window showing live view images from
all cameras simultaneously. Please note that the live view images are downloaded from each camera
in turn and so the display refresh rate for any given camera will depend on the number of cameras
connected.

Anaglyph Stereo Display

If two cameras are connected the multi live view display will show a checkbox for selecting a stereo
anaglyph display. When this is selected the live view images from the two cameras are combined into
a single red/cyan stereo anaglyph display consisting of the red channel from the first camera and the
green and blue channels from the second camera.

Multi-View

The multi-view option displays photos and previews from each connected camera in a grid together
with a caption identifying the camera. Multi-view mode can be enabled by selecting "Multi-view
mode..." from the View menu:

Multi-View Settings >

Enable multi-view preview mode

Preview caption:

| [{camera#}]: {id}

Cancel

The text used for the caption can be set using the "Preview caption:" edit box. The text can use tokens
to display additional information related to each camera e.g. {camera#} gives the camera number in
the array and {id} gives the camera id either as the author "Sort cameras by author" setting in file-
>Preferences.

When the multi-view option is selected the preview area in the main Multi-Camera window will be
divided up into a grid to give a preview area for each camera. When no preview is available the
preview will be displayed as a red rectangle with the camera number. When a photo is taken with each
camera a preview will be displayed in the grid. The previews can be cleared by pressing F3. The
previews are also cleared when pressing the "Release" button to take photos.

Video Capture

General Operation

Canon cameras can only capture video to the camera's memory card and with live view enabled. To
capture video with Multi-Camera first make sure each camera has a memory card with sufficient free
space and the camera is setup for video capture (please see below for information on how to setup
each camera model for video capture). While it is possible to use a mixture of different camera models
it is simpler if all the cameras are the same model.

Next, "Multi Live View" should be selected from the "Camera" menu and the "Rec" button pressed to
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start and stop video capture. During video capture a small red circle together with the approximate
duration of the video is displayed in the bottom left corner of each live view image. At the end of video
capture a small thumbnail file will be downloaded to Multi-Camera and displayed in the main window.
This thumbnail file has a .THM file extension and is for identification purposes only.

The main .MOV or .MP4 movie file is stored on the camera's memory card. To download the movie file
to the PC first close the live view window and then either select "Download movies..." from the Camera
menu or right click on the thumbnail image and select "Download movie". After a movie file has been
successfully downloaded it can be automatically deleted from the memory card to free up space (by
selecting the option to delete movie files in Preferences). The memory cards of all connected cameras
can also be formatted by selecting "Format memory card..." from the Camera menu. Please use this
option with care as it will erase the memory card and any images or movies that have not been
downloaded will be lost.

When using two cameras and starting the video capture by pressing the "Rec" button in the live view
window the video on both cameras should be synchronized to within approximately 1/10 second at the
start. Because each camera pauses while it finishes writing the video to the memory card at the end of
video capture the ends of the videos will not be accurately synchronized.

More accurate synchronization can be achieved with the Canon EOS-1D C, Canon EOS-1D X or
Canon EOS 5D Mark Il by starting and stopping video capture using the camera's shutter release and
triggering all the cameras via their remote release sockets. Please see this page on our website for
more information on triggering cameras. To enable this the cameras need to be setup so that the
shutter release button is configured to start/stop video capture (please see the camera instruction
manual for details on how to set this up). The 5D Mark Il must also be set to movie mode by setting
the movie/camera switch to the movie position.

Canon EOS 5D Mark IV

Please note that 720p 120fps fast video mode is not supported in Multi-Camera. If this setting is used
the camera may lock up and will need to be turned off and the battery removed to reset it.

Canon EOS 5D Mark I

Please use firmware version 2.0.4 or later for the best results. The latest camera firmware can be
downloaded from Canon's website.

In the camera settings the live view function setting should be set to "Stills+movie" and the screen
settings should be set to "Movie display". The "Movie rec. size" should be set to the required resolution
and frame rate as these cannot be set remotely from the PC.

Select "Multi Live View" in Multi-Camera (e.g. by typing Shift+Ctrl+L) and the live view window will be
displayed. This will show shaded areas defining the frame extent either above and below the image if
1920x1080 resolution is selected or to the left and right if 640x480 resolution is selected. Press on the
"Rec" button to start recording a video clip and a red circle together with the duration of the video will
appear in the bottom left corner of the live view display for each camera. Press the "Rec" button again
to stop recording - the red circle and video duration will disappear and a small thumbnail will be
automatically downloaded to the PC and displayed in the main DSLR Remote Pro window.

The camera's LCD needs to be turned on in order to use the camera's controls to capture video. This
can be done by pressing the live view button on the camera. The "Set" button can now be used to start
and stop recording.

Canon EOS 1D Mark IV, Canon EOS 6D, Canon EOS 70D and Canon
EOS 7D

These cameras have a dedicated movie/camera switch on the back of the camera. If this switch is in
the movie position when the camera is switched on the start/stop button needs to be pressed in order
to be able to use live view. Videos can be captured from the PC with the movie/camera switch in either
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position, but can only be controlled using the camera's start/stop button if the movie/camera switch is
in the movie position. The various options are described below:

Movie/camera switch in the movie position when camera turned on: run Multi-Camera and press
the start/stop button on the camera once it has connected to the camera. Videos can be started by
pressing the start/stop button on the camera and stopped by pressing the start/stop button again.
Videos can also be started and stopped from the PC by selecting "Multi Live View" (e.g. by typing
Shift+Ctrl+L) and pressing the "Rec" button.

Movie/camera switch in the camera position when camera turned on: video can be captured from
the PC by selecting "Multi Live View" (e.g. by typing Shift+Ctrl+L) and clicking on the "Video" button.
The live view images will display shaded areas defining the video extent and the video resolution and
frame rate will be displayed in the live view window title bar. Press on the "Rec" button to start
recording video and again to stop recording.

Canon EOS 100D/Rebel SL1, Canon EOS 700D/Rebel T5i, Canon
EOS 650D/Rebel T4i, EOS 600D/Rebel T3i, EOS 1200D/Rebel T5,

EOS 1100D/Rebel T3, EOS 550D/Rebel T2i and Canon EOS 60D

The EOS 100D/Rebel SL1, EOS 700D/Rebel T5i, EOS 650D/Rebel T4i, EOS 600D/Rebel T3i, EOS
1200D/Rebel T5, EOS 1100D/Rebel T3, EOS 550D/Rebel T2i and EOS 60D have a dedicated movie
setting on the camera's exposure mode dial. Videos can be captured from the PC with the exposure
mode dial set to any setting, but can only be controlled using the camera's record button if the
exposure dial is set to the movie position.

If the camera's exposure mode dial is set to the movie position video capture can be started by
pressing the record button on the camera and stopped by pressing the record button again.Videos can
also be started and stopped from the PC by selecting "Multi Live View" (e.g. by typing Shift+Ctrl+L) and
pressing the "Rec" button.

If the camera's exposure mode dial is not set to the movie position video capture can only be
controlled from the PC. To do this first select "Multi Live View (e.g. by typing Shift+Ctrl+L) and then
press the "Video" button. The live view images will display shaded areas defining the video extent and
the video resolution and frame rate will be displayed in the live view window title bar. Press on the
"Rec" button to start recording video and again to stop recording.

Canon EOS 500D/Rebel T1i

The EOS 500D/Rebel T1i has a dedicated movie setting on the camera's exposure mode dial and this
must be set to the movie position in order to be able to capture video. Please note that the Canon EOS
500D/Rebel T1i cannot be used for video capture from a PC without having access to the camera's
controls. In order to capture videos you must have access the camera to either turn the exposure
mode dial to the movie setting or to press the "Rec" button.

Exposure mode dial is set to the movie position when the camera is turned on: run Multi-
Camera and press the start/stop button on the camera once it has connected to the camera. If the
"Save to camera only" option is selected in Multi-Camera videos can be started by pressing the start/
stop button on the camera and stopped by pressing the start/stop button again. Videos can also be
started and stopped from the PC by selecting "Multi Live View" (e.g. by typing Shift+Ctrl+L) and
pressing the "Rec" button.

Exposure mode dial not set to the movie position when the camera is turned on: when Multi-
Camera is run normal live view operation is available but video capture is not possible. To enable
video capture turn the exposure mode dial to the movie position. If the "Save to camera only" option is
selected in Multi-Camera videos can be started by pressing the start/stop button on the camera and
stopped by pressing the start/stop button again. Videos can also be started and stopped from the PC
by selecting "Multi Live View" (e.g. by typing Shift+Ctrl+L) and pressing the "Rec" button.
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Trouble shooting

If "busy" is displayed on the camera's LCD when the "Rec" or "Start/Stop" button is pressed it means
that movie mode needs to be selected on the camera (either by turning the exposure mode dial to
movie or by setting the movie/camera switch to movie).

If nothing happens when "Rec" or "Start/Stop" button is pressed on the camera please try selecting the
"Save to camera only" option in Multi-Camera' Camera menu.

If the live view window does not display live view images you may need to press the "Rec" or "Start/
Stop" button on the camera.

4.9 Creating Animated GIFs and MP4s

J} Multi-Camera Animator v1.6.1 X

DSLR Remote Pro Multi-Camera - Connected to 5 cameras [Multi-view mode)
5 cameras, monitoring: C:\multi-camera

Mext GIF: 20170614_005.GIF

Saving GIFs and MP4s in: C:\multi-cameralGIF

17:37:29; Created: C:\multi-cameralGIF\20170614_001.GIF
17:37:46; Created: C:\multi-camera\GIF20170614_001.MP4
17:38:13: Created: C:\multi-camera\GIF\20170614_002_GIF
17:38:29; Created: C:\multi-camera\GIF\20170614_002.MP4
17:39:00; Created: C:\multi-camera\GIF\20170614_003.GIF
17:39:16: Created: C:\multi-camera\GIF\20170614_003.MP4
17:39:21: Created: C:\multi-camera\GIF\20170614_004.GIF
17:39:39; Created: C:\multi-camera\GIF\20170014_004.MP4

The Multi-Camera Animator utility can be used to automatically create animated GIFs of photos taken

by a mutli-camera rig. If provides the following features:

. Manual or auto alignment of photos

. Automatically tells Multi-Camera to save each set of photos in a separate folder

. Stabilizes the images from the cameras by panning, rotating and zooming the photos

. Optional cropping of images

. Automatically creates an animated GIF and/or MP4 movie file with optional overlays and title
pages

. Optionally chromakeys the images when shooting with a green or blue background

. Saves copies of stabilized images ready for alternative post-processing e.g. creating MP4 video
files in other applications

8. Optionally saves a copy of the middle photo so that it can be printed e.g. using Hotfolder Prints

9. Optionally creates an anaglyph stereo image from the middle two cameras for viewing in 3D

using red/cyan glasses

AN -

~N O

The Multi-Camera Animator can be run by selecting "Run Multi-Camera Animator" from the File menu
in Multi-Camera.
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Multi-Camera Settings

Select "Setup for Multi-Camera Animator..." from the File menu in Multi-Camera to check the settings
and automatically set them to default settings to work with the Multi-Camera Animator. This will set the
download folder, the filename prefix and the grid overlay settings. These can also be set manually as
described below.

Select File->Preferences in Multi-Camera and select "Sort cameras by Author", set the "Filename
prefix:" to {author}_, the "Directory in which to save images" to C:\multi-camera\{comment} and
uncheck the Year, Month and Day checkboxes as shown below:

D5LR Remote Pro Multi-Camera Preferences ot
Mouse button actions

Middle button: Mone “ | Right button: | Mone v

[]only download JFEGs to PC when shooting raw+IPEG

Gang camera shutter releases together, delay inms: |0
Gang camera settings together Sort cameras by Author
[]synchronize multiple copies of DSLR. Remote Pro Multi-Camera:

Saved image settings

[ ]Prefix filename with comment string || Lower caze file extensions
[ ] Append sequence letter to end of filenames when auto-bracketing
|:| Sort images into groups

Filename prefix: | {author}_ | Digits: =

Directory in which to save images:

| C:\multi-camera‘{comment} | s

Separate directory for: [ Year [ |Month [ ]Day
Flatten date (e.g 2016-07-14)

Sub-folder: | |

Example image name:
| C:\multi-camera‘{comment}_0123.IPG |

Cancel

Next, set the author string for each camera to identify its position in the camera array e.g. by setting
the author string for the first camera in the array to 001. This can be done using the controls on each
camera or by selecting the camera in the "Camera:" dropdown list in Multi-Camera and then selecting
Camera->Edit id...
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Canon EQS 530 Mark 1l ot

Camera serial number:

Owner string: | 001 |

Author: | o1 |

Copyright | |

Cancel

The author string can also be set using the camera's controls when it is not connected to a computer.
To do this click on the camera's "Menu" button and step through the menus until you find "Copyright
information"” in one of the tool menus. Select "Copyright information” then select "Enter author's name"
to view or edit the author's name. It's a good idea to turn the camera off using the camera's power
switch after editing the author's name to ensure that changes are saved properly. Some camera
models may lose the changes if they are externally powered and the power is cut instead of turning the
camera off using its power switch.

Tip: Set "Suppress image display" in the "View" menu in Multi-Camera to reduce the time it takes to
download the photos from the cameras

Date Based Folders

The default place to save the photos downloaded from the cameras is C:\Multi-Camera\{comment}
The Multi-Camera animator will set the comment field to the current date in the form YYYYMMDD
followed by a sequence number e.g. 20170620_001 for June 20, 2017. It is also possible to save the
photos in date based folders to make it easier to keep all the photos from an event together. This can
be done using the {year}, {month} and {day} tokens

e.g. C:\Multi-Camera\{year}-{month}-{day}\{comment}

If the event is likely to continue after midnight use the {yearLess8h}, {monthLess8h} and {daylLess8h}
tokens instead
e.g. C:\Multi-Camera\{yearLess8h}-{monthLess8h}-{dayLess8h}\{commentLess8h}

The {yearLess8h}, {monthLess8h} and {dayLess8h} use the current time less 8 hours when generating
the date e.qg. if an event starts at 9pm on June 20, 2017 the {day} token will give 20 before midnight
and 21 after midnight but the {dayLess8h} token will give 20 after midnight (up until 8am the next
morning).

Multi-Camera Animator Setup

Run the Multi-Camera Animator utility by selecting "Run Multi-Camera Animator" from the File menu in
Multi-Camera and then click on "Settings..." button to set it up:
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Settings X
Mumber of cameras: Image rotation: |Mone W

Link to Mult-Camera Only process filenames ending in 1

Save calibration settings with photos ] Run command Commamd...

[]5ave GIFs/MP4s with UID flenames
Folder to monitor:
| C:\multi-camera |

Animated GIF and MP4 settings. ..

GIF and MP4 output folder:
| C:\multi-camera‘GIF |

Create PMNG copies of stabilized photos Create PNG copies of each frame

[l Chromakey photos, folder for background and overlay images:  Chromakey Setfings...

Folder containing overlays and title pages:

| C:\multi-camera‘overlays |

Copy photo from middle camera to folder;
| C:\multi-camera'stills |

[ ] create anaglyph stereo photo from middle cameras, folder:

Load... Save... Cancel

Set the "Number of cameras:" to the number of cameras in the array.

Set the "Image rotation:" dropdown list to the camera orientation. If the cameras are in normal
landscape orientation this should be set to "none".

Select "Link to Multi-Camera" if you want the Multi-Camera Animator to automatically update the
download folder in Multi-Camera after each set of photos has been downloaded. If two copies of the
Multi-Camera are running (e.g. one copy to create small animated GIFs and one copy to create larger
MP4 files) only one copy should have "Link to Multi-Camera" enabled.

Select "Only process filenames ending in 1" to provide protection against cameras being triggered
twice in quick succession which results in additional images being downloaded to the current folder
and can cause strange out of sequence GIFs and MP4s. When this setting is selected only the first
image downloaded from each camera (with a flename ending in 1) will be processed.

The "Save calibration settings with photos" setting will save a copy of the current calibration settings in
the folder with the photos downloaded from the camera when creating the animated GIF. This is useful
if you need to recreate the animated GIFs at a later date. The calibration settings file is named using
the date and time in the form YYYYMMDD_ hhmmss_calibration.xml and can be loaded into the
calibration settings screen (which is displayed when you click on the "Calibrate..." button).

The calibration settings XML file also includes the filenames of the downloaded photos and the GIF or
MP4 files. Select "Run command" and click on the "Command..." button to run a command after
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saving the calibration settings XML file. This is useful if you need to automate the work flow e.g. by
copying the GIF file to a folder where it can be shared.

Select the "Save GIFs/MP4s with UID filenames" option to use hard to guess filenames when saving
GIFs and MP4s. This improves privacy when sharing files on a microsite because users won't be able
to guess the filenames of other guests' images.

When this option is selected the filenames will consist of 5 letters followed by 3 digits e.g.
ABCDEF123.GIF. The filename is generated from the computer name and download folder and
should be unique when using multiple systems provided the computers have different names.

Set the "Folder to monitor:" to the monitor the same folder as the "Download directory in which to save
images:" set up in Multi-Camera but without the {comment} token.

e.g. If Multi-Camera is set to C:\Multi-Camera\{comment} set the folder in the Multi-Camera Animator
to C:\Multi-Camera

If Multi-Camera is set to C:\Multi-Camera\{year}-{month}-{day}\{comment} set the folder in the Multi-
Camera Animator to C:\Multi-Camera\{year}-{month}-{day}

Next set the "GIF and MP4 output folder" to where you want the GIFs and MP4s to be saved. Then
click on the "Animated GIF and MP4 Settings..." button to specify how the animated GIFs and/or MP4
movies should be created:

Animated GIF and MP4 Settings

Photo width (pixels):
Photo left offset: Photo top offset:

Frame width (0=use photo width): Frame height (0=use photo height):

17 .

Frames per photo: Mumber of times to display seq:
Image interval (1100 sec):

Title display time {1,100 sec):

T

Display title at end of the animation
"Ping-pong” forwards backwards display
[ create GIF
Dither GIFs for improved color at the expense of detail
Create MP4

Minirmum duration {sec): Advanced settings...

Cancel

I

The "Photo width (pixels):" setting specifies the width of each photo to be added to the animated GIF
(after stabilizing and cropping).

Set the "Frame width" and "Frame height" to the required size if the animated GIF or MP4 is a different
size to the individual photos. Use the "Photo left offset" and "Photo right offset" setting to specify where
the photo should be placed within the frame. The offsets are specified in pixels.

The "Frames per photo" setting controls how many animation frames are displayed for each photo.
This provides a way to display an overlay animation that has a higher frame rate than photo animation
e.g. if "frames per photo" is set to 2 for a boomerang sequence from 5 cameras the animation frames
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would be:

Frame 1: photo from camera 1 + frame_overlay_1.png
Frame 2: photo from camera 1 + frame_overlay_2.png
Frame 3: photo from camera 2 + frame_overlay_3.png
Frame 4: photo from camera 2 + frame_overlay_4.png
Frame 5: photo from camera 3 + frame_overlay_5.png
Frame 6: photo from camera 3 + frame_overlay_6.png
Frame 7: photo from camera 4 + frame_overlay_7.png
Frame 8: photo from camera 4 + frame_overlay_8.png
Frame 9: photo from camera 5 + frame_overlay_9.png
Frame 10: photo from camera 5 + frame_overlay_10.png
Frame 11: photo from camera 4 + frame_overlay_11.png
Frame 12: photo from camera 4 + frame_overlay_12.png
Frame 13: photo from camera 3 + frame_overlay_13.png
Frame 14: photo from camera 3 + frame_overlay_14.png
Frame 15: photo from camera 2 + frame_overlay_15.png
Frame 16: photo from camera 2 + frame_overlay_16.png
Frame 17: photo from camera 1 + frame_overlay_17.png
Frame 18: photo from camera 1 + frame_overlay_18.png

Use the "Number of times to display seq" to add multiple copies of the photo sequence to the
animation when using title pages. For example if there is a title page and 5 photos the sequence will
be title, 1, 2, 3, 4, 5 when this is set to 1 and title, 1, 2, 3,4, 5, 1, 2, 3, 4, 5 when it is set to 2. This
setting is ignored if no title pages are defined.

The default setting is 1.

Specify how long each frame should be displayed using the "Image interval (1/100 sec)" setting and
how long each title page should be displayed using the "Title display time (1/100 sec)" setting.

Normally title pages are added to the end of the sequence so that when animated GIFs are viewed in a
browser or kiosk (e.g. Breeze Kiosk) the first photo in the sequence is displayed not the title page
(which would be the same for all the animated GIFs being viewed). Uncheck "Display title at end of
animation" to display the title pages at the start.

Select the "Ping-pong forwards/backwards display" option to add the photos in reverse order to the
animation. This setting is useful if the camera array doesn't form a full circle and will display an
animation that plays the photos forwards then backwards in a loop instead of jumping back to the start
each time. e.g. the photos from a 5 camera rig will be displayed in the order 1, 2, 3, 4, 5, 4, 3, 2,1, 2,
3... when this option is selected or as 1, 2, 3, 4, 5, 1, 2, 3... when it is not selected.

Overlays can be added to the photos by placing PNG overlay files in the overlays and titles folder. A
single overlay can be used for all the photos by placing a PNG image named photo_overlay.png in the
folder. Different overlays for each photo can be added by naming the PNG images photo_overlay_1.
png, photo_overlay_2.png, photo_overlay 3 png etc. The PNG overlay files should be created with
transparency information in the alpha channel. If the overlays are wider than the resized photos they
are resized to the same width. If the overlay is smaller than the photo its placement is bottom right
justified. This means a small logo can be placed in the bottom right corner of each photo simply by
creating a small PNG image and naming it photo_overlay.png.

Titles can be added to the animated GIF by placing one or more JPEG title images in the overlays and
titles folder. A single title image can be added by placing a JPEG image named title.jpg in the folder. A
sequence of title images can be added by naming them title_1.jpg, title_2.jpg, title_3.jpg etc. If the title
images are wider than the animated GIF they are resized to the same width and then placed centered
in a frame with a white background.

An optional soundtrack can be added to the MP4 copy of the animated GIF by placing a MP3 file
named soundtrack.mp3 or a WAV file named soundtrack.wav in the overlays and titles folder. Please
note that animated GIFs do not support sound and so the soundtrack will only be added to the MP4
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video.

After creating the frames for the animation (including the reverse display if "ping-pong" is selected) an
optional overlay can be added to each frame by placing PNG overlay files in the overlays and titles
folder. A single overlay can be used for all the frames by placing a PNG image named frame_overlay.
png in the folder. Different overlays for each frame can be added by naming the PNG images
frame_overlay_1.png, frame_overlay 2.png, frame_overlay 3 png etc. The PNG overlay files should
be created with transparency information in the alpha channel. If the overlays are wider than the GIF
width they are resized to the same width.

Select "Create GIF" to create an animated GIF of the sequence and/or "Create MP4" to create an MP4
movie of the sequence. Set the minimum duration of the movie in secs or set this to 0 to make the
movie as short as possible. This option is useful if the movie file is to be uploaded to a site which has a
minimum length requirement (e.g. videos posted to Instagram must be at least 3 seconds long). If the
movie file will be shorter than the minimum length the GIF frames, but not the title frames, will be
repeated until the movie is long enough.

The Multi-Camera Animator can either use the Microsoft MediaWriter libraries or the open source
ffmpeg command line tools (https://ffmpeg.org/) to create MP4 files. Advanced users can edit the
settings used to create MP4 files by clicking on the "Advanced settings..." button:

MP4 Settings (Advanced users only) X

|Ise MediaWriter to create MP4s (faster than ffmpeg)

Video bit rate: | 2000000

ffmpeg command line to create MP4 files:

-vf "scale=trunc(w/2)*2:trunc(ih/2)*2, fps=25, format=yuv420p" -c:v libx264 preset veryfast

Or choose one of the presets below. The faster settings reduce the processing time but may result in larger file
sizes and reduced image quality.

Very slow Slow Fast Very flast (default] tra fast

Cancel

Using MediaWriter to create MP4 videos

The Microsoft MediaWriter libraries are much faster than the ffmpeg option but don't offer as many
configuration options. The "Video bit rate" setting affects the quality of the video, the size of the MP4
file and the speed of processing. Increasing this setting will increase the quality of the video output.
MP4 videos created using the MediaWriter libraries must have a width which is a multiple of 4 and a
height which is an even number. If the width is not a multiple of 4 the video will be automatically
trimmed by removing pixels from the left and right to make the width a multiple of 4. If the height is not
an even number the bottom row of pixels will be discarded.

The default setting is to use the MediaWriter libraries to create MP4 files with the video bit rate set to
2000000.

Using ffmpeg to create MP4 videos

Unselect "Use MediaWriter to create MP4s" to use the ffmpeg command line tools to create MP4
videos. This is the method used to create MP4 videos in older releases of the Multi-Camera Animator
and offers more options for controlling the quality of the output.

MP4 videos created using the ffmpeg option must have a width and a height which are even numbers.
If the width is not an event number the right most pixel on each row will be discarded. If the height is
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not an even number the bottom row of pixels will be discarded.

Click on the "Very slow", "Slow", "Fast", "Very fast (default)" or "Ultra fast" buttons to select different
presets for ffmpeg. The "Very fast" and "Ultra fast" options are considerably faster than the slow
options but may result in a small reduction in quality or larger file sizes. Please experiment with
different settings to find the one that gives the best balance between speed, quality and file size for
your application.

Select the "Create PNG copies of stabilized photos" if you want to use another application such as
Adobe After Effects to post process the photos. This will save a copy of each frame after it has been
stabilized, chromakeyed (if selected) and cropped.

The PNG images will be the same size as the original photos. Each PNG copy of the stabilized photos
will be saved in the same folder as the JPEG images downloaded from the cameras and will have the
same filenames but with a PNG file extension.

Select the "Create PNG copies of each frame" if you want to be able to use a script or other application
to post process the frames (e.g. to create a MP4 movie of the sequence). This option differs from the
"Create PNG copies of stabilized photos" option because it is a copy of the frame that is added to the
GIF and may display the photo within a larger image and have an optional frame_overlay.png added.
Also, if the "ping-pong" option is enabled in the animated GIF settings frames will be saved for the
reverse display.

The photos in the PNG images will be resized to the "Photo width" settings and the placed in a frame
according to the frame width and height settings. Each frame will be saved in the same folder as the
JPEG images downloaded from the cameras and will be named frame_1.png, frame_2.png etc.

Select the copy photo from middle camera to save a stabilized (and optionally chromakeyed) copy of
the the photo from the middle camera in a separate folder. The photo is saved as a JPEG using the
current folder name e.g. if the photos are downloaded into the folder C:\Multi-camera\20160801_001
the photo will be named 20160801_001.jpg.

This option is useful if you want to be able to give users a print. Our Hotfolder Prints software can be
used to automatically format and print the photo and include additional information such as branding or
a QR code linking to a website where the animated GIF can be viewed.

Select the "Create anaglyph stereo photo from middle cameras" to create a stereo image which can be
viewed using red/cyan glasses to give a 3D effect. The photo is saved as a JPEG using the current
folder name followed by _anaglyphe.g. if the photos are downloaded into the folder C:\Multi-
camera\20160801_001 the anaglyph stereo photo will be named 20160801_001_anaglyph.jpg.

For best results the cameras should be spaced approximately the same distance apart as your eyes
(approximately 65mm to 70mm). It is still possible to get a good 3D effect with the cameras
considerably wider apart than an average person's eyes, but if they are too far apart it will be difficult to
view the photos in 3D stereo.

The settings can be saved to file by clicking on the "Save..." button. The saved settings can be loaded
by clicking on the "Load..." button or by dragging and dropping the settings file on the main Multi-
Camera Animator window or by adding the path of the settings file to the command line used to run the
Multi-Camera animator.

Dithered vs Indexed Color

Animated GIFs can only display 256 different colors per frame which causes a problem when trying to
display photos which typically have many more colors. There are two ways to handle this limitation:

1) Dithered color where the color of each pixel is represented by several pixels

2) Indexed color where the 256 most common colors in the photo are used

Dithered images can give a better representation of the colors in the original photo but will provide less
detail for a given image size. Indexed colors give better detail and usually give adequate colors but
may show some contouring or shimmering with some photos, particularly if there are areas of

© 2021 Breeze Systems Ltd



Multi-camera Operation 45

graduated color in the original photo.

Indexed color is recommended for most applications for animated GIFs and so the "Dither GIFs to give
better color" option should normally be left unchecked. This setting does not affect the colors in MP4
movie files.

Chromakeying (aka green screen)

Select the "Chromakey photos" option and select the folder where backgrounds and optional overlay
images are stored. There needs to be a background image for the photos from each camera and
these should be named chromakey_background_1.jpg, chromakey_background_2.jpg,
chromakey_background_3.jpg etc. Optional overlays can be added to the images from each camera
by naming them chromakey_overlay_1.png, chromakey_overlay 2.png, chromakey_overlay _3.png
etc.

Take a test set of photos and then click on the "Chromakey settings..." button to adjust the settings.
This will open a window with controls for adjusting the chromakeying and previews from each camera
showing the effect.

Hue: 140 I

Hue variation: 29 I

Satruation threshaold: 15 I

Cancel Display overlays

Start by setting the "Hue variation" slider to a low value such as 5 and the "Saturation threshold" to 15.
Then move the "Hue" slider until the maximum amount of background is replaced by the
chromakey_background JPEG images. Then adjust the "Hue variation" until the all the background is
replaced in each photo.

If the photos are very noisy (e.g. because they were shot with a high ISO setting) there may be colored
speckles in the background. This can be reduced by increasing the "Saturation threshold" setting.

Calibration Photos

Place a vertical pole or a pole with a plumb line at the center of the circle in front of the camera array.
Mark the mid point of the pole or plumb line with tape or some other reference marker to provide a
target for aligning and focusing the cameras. Add a second marker near the bottom of the pole to
provide a reference for scaling the photos.

Tip: Using a high contrast marker for the center reference point will make it easier to focus the
cameras accurately.

Align and focus each camera in turn by selecting the camera from the "Camera:" dropdown list and
selecting live view. Right click on the live view display and select "Grid settings":
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Grid Settings >

Mumber of horizontal divisions: | 2

Mumber of vertical divisions: 2

4

Display area for print size
Print aspect ratio (e.g. 10x8): |2? | X | 16 |

Line color: .

Enable grid display

Cancel

Set the number of horizontal and vertical divisions to 2 and enable the grid display so that a crosshair
is displayed in live view.

Select "Display area for print size" and set the print aspect ratio to 27 x 16. This two horizontal lines on
the live view: one near the top of the frame and one near the bottom. Move the bottom marker on the
pole or plumb line so that it lines up where the bottom line crosses the center line of the crosshair. This
will provide a useful reference point when adjusting the zoom setting when stabilizing the images:

W Live View (camera 3 of 5): full frame

E;

!

Live view display with crosshair and crop overlay to aid alignment

Click the "Next Camera" or "Previous Camera" buttons to select the middle camera of the array. If the
cameras have zoom lenses make sure they are all set to the same zoom setting (normally this is the
widest setting when using a standard 18-55mm kit lens).

Align the camera so that the center of the cross hair is over the middle reference on the pole or plumb
line. Also adjust the camera so that the vertical line of the cross hair lines up with the vertical pole or
plumb line reference.

Adjust the position of the lower reference marker so that it lines up with the lower crosshair.

Set the camera to manual focus, zoom the live view and adjust the focus by turning the focus ring on
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the camera lens.

Don't worry about getting perfect camera alignment as small errors can be compensated for in Multi-
Camera Animator. Take care to focus the camera accurately as this will affect the quality of the final
results.

Repeat the above procedure for all the cameras in the array.

Click on the "Calibration folder" button in the Multi-Camera Animator main window to setup Multi-
Camera to save the calibration photos in a new folder. This will set the "Comment:" field in Multi-
Camera's main window to "Calibration" followed by the date and a sequence number e.g.
Calibrate_170613_1 for calibration photos taken on June 13, 2017. Then trigger the cameras to take a
set of test shots.If the photos need to be re-taken (e.g. because the exposure settings were wrong)
press the "Calibration folder" button in the Multi-Camera Animator to create a new calibration folder e.
g. Calibrate_170613_2

Cameras in portrait orientation

Select "Portrait (90 degrees CW)" or "Portrait (90 degrees CCW)" from the View menu in the main
Multi-Camera window if the cameras are in portrait orientation. This will display them with the correct
orientation when taking tests photos and when using live view.

Set the grid aspect ratio to 27 x 17 when the cameras are mounted in portrait orientation.

Software Alignment

The Multi-Camera Animator offers both automatic and manual alignment options. It is worth trying both
methods to see which works best for you. Our current favorite method is manual alignment.

1) Manual Camera Alignment
Run the Multi-camera Animator, click on the "Calibrate..." and select the folder containing the

calibration photos (by default it will use the last folder created by clicking on the "Calibration folder"
button):
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The top left corner lists the cameras with a preview of the stabilized photo from the currently selected
camera shown below. The right hand side of the window shows top, middle and bottom portions of the
photo together with cross hairs for aligning them. The suggested alignment procedure is as follows:

1. Select "Zoom display" to zoom in on the previews on the right hand side

2. Left click the mouse in the middle preview to center the image in the cross hairs e.g. left click on
the center of the target in the screenshot above. The positioning can be fine tuned by holding
down the shift key and pressing the cursor left, right, up and down keys.

3. Left click on the top most or bottom most previews to rotate and scale the image to line up with
the cross hair e.g. left click on the center of the target in the bottom preview in the screenshot
above. The rotation can be fine tuned by holding down the Ctrl key and pressing the cursor left
or cursor right keys or zoomed by holding down the Ctrl key and pressing the cursor up or down
keys.

4. Select the next camera by pressing the cursor down key and repeat steps 1 to 3

Use the cursor up/down keys or press the "Play" button to step through the cameras to check the
alignment. The image in the bottom left corner of the display shows the photo from the currently
selected photo.

The photos can also be zoomed in or out to compensate for differences in the camera lenses or minor
errors in the zoom setting. To do this you need to make sure the calibration photos have a suitable
reference point which is close to the cross hair in the top or bottom previews. If necessary, move the
reference marker and re-take the calibration photos. Then right click the mouse to rotate and scale the
image to line up with the bottom cross hairs e.g. right click on the center of the target in the screenshot
above. The scaling can be fine tuned by holding down the Ctrl key and pressing cursor up or cursor
down keys.

Check the alignment by pressing the "Play" button and fine tune the settings if required.

2) Auto Camera Alignment
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The cameras can be automatically aligned if the calibration photos are taken with bright lights or high
contrast markers placed at the center and lower reference points. For best results use bright LED
lights and adjust the camera exposure settings so that the calibration photos are dark except for the
reference lights. To do this turn off the studio strobes and reduce the ambient lighting if possible and
then set the camera I1SO to 100, the aperture to /5.6 and the shutter speed to 1/250 sec. Take a test
photo by clicking on the "Preview" button in Multi-Camera. If the background in the test shot is bright
try selecting a faster shutter speed and taking another test shot. If the reference lights are not visible
try selecting a slower shutter speed and taking another test shot.

Tip: It is better to use a wide aperture as this will give better results for auto alignment. Using a very
small aperture (e.g. f/22) may result in star bursts from the point light sources which will make auto
alignment more difficult.

Ideally the test photo should have a dark background with the reference lights visible as white spots in
the center and bottom of the photo similar to the calibration photo below:

el

When the exposure is set correctly take a set of calibration photos by clicking on the "Release" button
or by triggering the cameras using the camera trigger system.

Run the Multi-camera Animator, click on the "Calibrate..." and select the folder containing the
calibration photos (by default it will use the last folder created by clicking on the "Calibration folder"
button). The press the "Auto align" button to align the photos. If auto alignment succeeds it will display
a message saying "All images successfully aligned. Press the "Play" button to cycle through the
images to check the alignment using the photo in the bottom left corner of the window. If the auto
alignment fails click on the "..." button to the right of the "Auto align" button to adjust the settings:
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Auto Alignment Settings X

Size of target area: | Small
Intensity threshold (default=0.7): 0.7
Saturation threshold (default=0,2); | 0.2

Maximum cluster count (default=50):

smallest allowable duster size (default=3 pixels):
Cancel

ill |

The size of the target area setting defines the size of the area that is scanned. This setting only needs
to be changed if the cameras are poorly aligned when the calibration photos were taken. Setting the
area to "Large" may cause auto alignment to run slower and increase the likelihood of detecting
unwanted areas.

The intensity threshold sets the brightness level used to detect the reference areas. If bright LEDs are
used for the reference lights this setting can be increased. Try setting it to 0.9 or 0.95 to improve the
accuracy of the auto alignment.

If high contrast markers (e.g. small white circular pieces of paper) are used it may be necessary to
reduce the intensity threshold to allow less bright pixels in the reference areas to be detected.

The saturation threshold controls the range of saturations used to detect the reference areas. If bright
white LEDs are used the target areas should be highly saturated and the saturation threshold can be
reduced.

If high contrast markers (e.g. small white circular pieces of paper) are used it may be necessary to
increase the saturation threshold to allow pixels that aren't pure white to be detected.

The auto alignment process detects clusters of pixels within the target area. If the background is too
bright the auto alignment process may detect a large number of clusters and could take a long time to
run. The "Maximum cluster count" sets the maximum number of clusters allowable before the auto
alignment process is abandoned. It isn't normally necessary to change this setting.

The smallest allowable cluster size setting controls how big a cluster of pixels needs to be to be
detected by the auto alignment process. This setting can be increased to reduce the number of
spurious areas that are detected when there is a bright background.

Type Shift+Ctrl+1 to turn on the debugging display. This will show the target areas as white rectangles
and the detected clusters as colored areas. Ideally the reference lights should appear as a single
cluster of pixels in the same color. If this is not the case try clicking on the "..." button and adjusting the
intensity and saturation thresholds.

The debugging display can be turned off by typing Shift+Ctrl+1 again.

If auto alignment doesn't give perfect alignment the alignment it can be fine tuned using the manual
alignment settings described in the "Manual camera alignment" section above.

Cameras in portrait orientation
Set "Image rotation:" in the Multi-Camera Animator's setting to 90 degrees or 270 degrees if the
cameras are mounted in portrait orientation.
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Cropping

If the alignment has been adjusted the margins of the previews displayed in the bottom left corner of
the calibration screen may show yellow borders to indicate areas outside the frame captured by the
camera. Select "Crop images" to crop the frames to remove the borders. Adjust the "Sides" setting to
crop equal amounts from the left and right of each frame: vertical yellow dashed lines either side of the
image will show the cropped area. Use the "Top" and "Bottom" settings to crop portions from the top or
bottom of the frames. When the "Play" button is pressed the sequence will be displayed with the
cropped areas masked off in black. The crop settings can also be used to crop unwanted portions
from the photos.

Creating Animated GIFs and MP4 files

When the cameras are correctly aligned click on the "Save..." button to save the calibration settings to
file for future reference.

Then click on the "Run..." button. The Multi-Camera Animator will automatically set the "Comment:"
field in Multi-Camera to the date followed by a three digit sequence number e.g. 20160630_001. This
is where the next set of photos taken by the camera array will be stored. When the photos are taken
the Multi-Camera Animator will create an animated GIF of the photos using the calibration settings set
up earlier and will automatically increment the sequence number in the "Comment:" field ready for the
next set of photos.

How it Works

When a set of photos are taken Multi-Camera automatically downloads the photos from each camera
into the current folder and names them according to which camera took each photo: 01_01.JPG,
02_01.JPG, 03_01.JPG etc.

Multi-Camera Animator monitors the download folder and when it detects the photos it updates the
comments field in Multi-Camera so that the next set of photos are saved into a new folder. The folders
are named sequentially using the date in the form YYYYMMDD e.g. 20160801_001, 20160801_002,
20160801_003 etc.

Multi-Camera Animator processes the images as follows:

1. Each photo is adjusted for pan, tilt, roll and zoom

2. If chromakeying (aka green screen) is enabled each photo is chromakeyed and the background
replaced with the virtual background (chromakey_background_1.jpg,
chromakey_background_2.jpg etc) and optional chromakey overlay (chromakey_overlay_1.png,
chromakey_overlay_2.png etc).

3. Photos are cropped using the values defined in the animated GIF settings

4. If the "Copy folder from middle camera to folder" option is selected the photo from the middle
camera is saved in a separate folder as a JPEG image. The image is named using the current
folder name e.g. if the photos are downloaded into the folder C:\Multi-camera\20160801_001
the photo will be named 20160801_001.jpg.

5. If the "Create anaglyph stereo photo from middle cameras" option is selected the photos from
two cameras in the middle are combined to create a red/cyan anglyph stereo pair and saved as
a JPEG image. The anaglyph stereo image is named using the current folder name e.g. if the
photos are downloaded into the folder C:\Multi-camera\20160801_001 the photo will be named
20160801_001_anaglyph.jpg.

6. The photos are resized to the "Photo width" specified in the animated GIF settings and an
optional overlay is added. A different overlay can be added for each photo by naming them
photo_overlay 1.png, photo_overlay_2.png, photo_overlay_3.png etc. or the same overlay can
be used for all the photos by naming it photo_overlay.png

7. If the "Create PNG copies of stabilized photos" is selected a copy of each photo is now is saved
as a PNG file in the same folder as the JPEG images downloaded from the cameras. Each
photo will have the same filename as the JPEG photo downloaded from the camera but with a
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PNG file extension

8. If the "ping-pong" option is selected in the animated GIF settings copies of the photos are added
to the end of the sequence in reverse order

9. If the GIF width and height in the animated GIF settings are different to the width of the photo a
frame with a white background is created and the photo is added using the x and y offsets
specified in the animated GIF settings

10. An optional frame overlay is added to each frame in the animation. A different overlay can be
added for each frame by naming them frame_overlay 1.png, frame_overlay_2.png,
frame_overlay_3.png etc. or the same overlay can be used for all the frames by naming it
frame_overlay.png

11.An optional soundtrack is added to the MP4 video by placing a soundtrack.mp3 or soundtrack.
wav file in the overlays and title folder

12. If the "Create PNG copies of each frame" is selected a copy of each frame is now is saved as
a PNG file in the same folder as the JPEG images downloaded from the cameras. The frames
are named frame_1.png, frame_2.png, frame_3.png etc.

13. If one or more title pages are found in the overlays and title pages folder (named title_1.jpg,
title_2.jpg etc.) title frames are created ready to be added to the animation. If title pages are
larger than the animated GIF they are resized to fit and are then centered on each frame
against a white background.

14. If title pages are defined and the "Number of times to display seq" is greater than 1 the photo
frames in the animation are repeated the specified number of times

15. If title pages are defined they are added to the start or end of the sequence depending on the
"Display title at end of the animation" setting

16. Finally the animated GIF and/or MP4 movie file of the whole sequence is saved in the GIF and
MP4 output folder and named using the current folder name e.g. if the photos are downloaded
into the folder C:\Multi-camera\20160801_001 the animated GIF will be named 20160801 _001.

gif

Photo Booth Mode

Photo booth mode provides a live view display and automated countdown for taking multi-camera
photos similar to a normal photo booth. Currently photo booth mode can be used with TriggerBox from
ESPER or with other camera triggers by using PhidgetsinterfaceKit 0/0/4 or PhidgetsinterfaceKit 0/0/8
relays.

The shooting sequence

The sequence starts with the ready screen and a live view display taken from the middle camera. A
keyboard shortcut or touchscreen action can be used to start a countdown or to take the photos
immediately.

At the end of the countdown the live view display is disabled and a command is sent to the TriggerBox
to take the photos.

When the photo from the middle camera has been downloaded a preview photo is displayed on the
screen while the software waits for the animated GIF or MP4 file to be created by the Multi-Camera
Animator. When the animated GIF/MP4 is available it is displayed on the screen for a preset time after
which the ready screen is displayed ready for the next set of photos.

A standby screen can be displayed when the system is not in use. This can be selected by using a
touchscreen action or by an inactivity timeout. The camera live view is disabled when the standby
screen is displayed to prevent possible problems with the camera sensor overheating.

Images displayed to the user

The screens displayed to users are defined by JPEG images which should be the same size as the
screen. The screens can be animated by adding an animated GIF or MP4 file with the same name as
the screen image file.
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The following screen images are available:

ready.jpg - displayed when the photo booth is ready to take the next set of photos. Live view images
from the middle camera are displayed

ready_no_live_view.jpg - similar to the ready.jpg screen but no live view is displayed. This allows the
camera to be triggered directly via the camera trigger (e.g. TriggerBox) with the minimum delay
countdown.jpg - displayed during the countdown before triggering the cameras. Live view images from
the middle camera are displayed

taking.jpg - displayed just before the command to take the photos is displayed. Live view from the
middle camera is disabled

release.jpg - displayed when the command to trigger the cameras is sent

processing.jpg - displays the photo from the middle camera while waiting for the animated GIF/MP4
movie to be created

playback.jpg - displays the animated GIF/MP4 movie for a preset time or until closed by the user
standby.jpg - displayed when the photo booth is in standby mode. Live view is disabled to prevent the
camera sensor from overheating

trigger_connecting.jpg - displayed at startup when attempting to connect to the camera trigger
trigger_error.jpg - displayed if there is a problem connecting to the camera trigger
camera_not_connected.jpg - displayed if the connection to the cameras is lost

timeout.jpg - displayed if the photo from the middle camera is not downloaded before the download
timeout

processing_timeout.jpg - displayed is the animated GIF/MP4 movie is not created before the
processing timeout

Using animated GIF files to animate screens

Each screen can be animated using an optional animated GIF by placing a GIF with the screen's name
in the photo booth images folder e.g. ready.gif for the ready.jpg screen.

If the GIF should play in a continuous loop the suffix _loop should be added to the filename e.g.
ready_loop.gif.

Animated GIFs are displayed on an overlay layer and can be placed over the live view display. Use the
transparent background color in the animated GIF to create transparent areas - the live view images
will be visible behind the transparent areas.

By default the animated GIF will be centered on the screen. The position can be specified by
appending the following modifiers enclosed in curly brackets to the end of the filename:

T - place the center of the animated GIF at the top of the screen

B - place the center of the animated GIF at the bottom of the screen

L - place the center of the animated GIF at the left of the screen

R - place the center of the animated GIF at the right of the screen

W - width of the animated GIF

H - height of the animated GIF

Each modifier can be followed by a number (to specify the offset in pixels) or a number followed by %
(to specify the percentage offset wrt the screen size).

Examples:

ready.qgif - place a GIF that plays once in the ready screen and place it in the center of the screen
ready_loop.gif - place a GIF that plays in a continuous loop in the ready screen and place it in the
center of the screen

ready_loop_{T}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center at the top of the screen (the top half will be off the screen), centered horizontally
ready_loop_{T50}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center 50 pixels down from the top of the screen, centered horizontally

ready_loop_{T10%}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center 10% of the screen height from the top of the screen, centered horizontally
ready_loop_{T10%L}.gif - place a GIF that plays in a continuous loop in the ready screen and place its
center on the left of the screen and 10% of the screen height from the top of the screen
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ready_loop_{B100R50}.gif - place a GIF that plays in a continuous loop in the ready screen and place
its center 50 pixels from the right side of the screen, 100 pixels from the bottom of the screen
ready_loop_{T10%W10%}.gif - place a GIF that plays in a continuous loop in the ready screen and
place its center 10% of the screen height from the top of the screen, centered horizontally and resize
to 10% of the screen width

When an animated GIF is displayed on the countdown screen it replaces the normal countdown text
and is only played once. Near the end of the GIF the taking.jpg screen is displayed and then
command to trigger the cameras is sent when the GIF reaches the end.

There is an example countdown.gif in the installation folder. This displays a 5, 4, 3, 2, 1 counter with a
progress ring. To test this copy countdown.gif to your photo booth images folder, run the photo booth
and press start.

Using MP4 movie files to animate screens

Each screen can also be animated using an optional movie file by placing a MP4 movie with the
screen's name in the photo booth images folder e.g. ready.mp4 for the ready.jpg screen. MP4
animations have the same looping, sizing and positioning options as animated GIFs e.g. to play a
movie file in a continuous loop in the ready screen name the file ready_loop.mp4.

Movie files are played on the background layer and will appear behind the live view display. A single
continuously looping movie file can be played in the background of each screen by naming it
background_loop.mp4. The background movie will be played unless there is a movie file with the
current screen name.

Set Up

Select Photo booth settings... from the File menu to display the "Photo Booth Settings" dialog:
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Photo Booth Settings X

Photo booth images folder:

C:\Users\chris\Documents\MultiCamera

Countdown text
Font: | Arial, 160 point

Text color: .

Text offset (0=auto): | 280

Mirror live view Bright live view mode

|:| Display calibrated live view (more accurate but slower)

Countdown duration: 3 Processing timeout: 30
Inactivity timeout (0=disabled): | 60 Error display time: 10
Playback timeout (O=disabled): |30 Live view cancel time (ms): | 500
Photo download timeout: 15 AF pre-trigger (ms): 100

Touchscreen settings...

oK Cancel

Set the photo booth images folder to the folder where the screen images are stored. The default
location is a folder named MultiCamera in your Document folder.

Use the countdown text font, color and offset settings to control how the countdown text is displayed.
The countdown text is displayed as a simple numeric countdown and is centered on the screen. The
text offset specifies its vertical placement measured in pixels from the top of the screen. Please note
that the countdown text is not displayed if a countdown.gif animated GIF is found in the photo booth
images folder.

Select the "mirror live view" option to mirror the live view images displayed from the middle camera in
the ready and countdown screens. Most guest are used to seeing themselves in a mirror and will find it
easier to place themselves in the frame if this option is selected. You may wish to disable this option if
the backdrop contains text (otherwise it will be mirrored too).

Select "bright live view mode" if you are using flash and the live view images are too dark. When the
bright live view mode option is selected the shutter speed of the middle camera can be adjusted using
the cursor up and cursor down keys or the "brighter" and "darker" touchscreen actions. The shutter
speed will be automatically set to the normal photo taking shutter speed before triggering the cameras.
This option is not necessary when using mid-range or high end cameras which have the option to
disable live view exposure simulation in th camera settings.

Tip: When using Rebel series cameras that do not have a B setting on the exposure mode dial you
can select auto exposure in live view by repeatedly pressing the cursor up key.
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Select "Display calibrated live view" for a more accurate live view display. This will rotate and zoom the
live view images to match the calibration settings in the Multi-Camera Animator. This option may result
in less smooth live view images on computers which don't have fast graphics in which case it should
be disabled. When this setting is disabled the live view images are only cropped to match the Multi-
Camera Animator settings.

The "Inactivity timeout" is the time in seconds before standby mode is selected when in ready mode.
Use this option to disable live view to avoid the camera sensor overheating when the system is not in
use.

Set the inactivity timeout to 0 to disable the timeout.

The "Playback timeout" settings is the time in seconds that the animated GIF or MP4 movie files
should be displayed in the playback.jpg screen. At the end of the timeout the ready screen is displayed
ready for the next set of photos. The playback.jpg screen can also be closed using the "Close
playback" touchscreen action.

The "Photo download timeout" setting is the time in seconds the booth waits for the photo from the
middle camera to be downloaded after triggering the cameras. If the photo is downloaded before the
timeout it is displayed in the processing.jpg screen. If there is a problem with the camera triggers or
with downloading the photos the timeout.jpg screen will be displayed.

The "Processing timeout" setting is the time in seconds the booth waits for the Multi-Camera Animator
to create the animated GIF or MP4 movie file. If the animated GIF or movie file is created before the
timeout it is displayed in the playback.jpg screen. If the timeout occurs before the animated GIF or
MP4 movie file is created the processing_timeout.jpg screen is displayed.

The "Live view cancel time" specifies the time, in milli-seconds, before the end of the countdown when
the live view should be canceled. It takes approximately half a second to cancel the live view before
taking a photo.

The "AF pre-trigger" time controls how long before triggering the cameras that the AF signal should be
activated. Pressing AF a short period before taking the photos will give better synchronization between
the cameras.

Click on the "Touchscreen settings..." button to edit the touchscreen actions on each of the screens:
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Touchscreen Settings >
Select the touchscreen actions and coordinates Fage: |1:actions 1to 15 | |Previous Mext
Action 1: | Start countdown » Lef't:| 249 | Tap: | a0 | Right:| 1652 | Bottom: | 859
Action 2 [Ready to standby v | Left:[ 1770 | Top: [980 | Right: [ 1920 | Bottom:
Action 3: | Standby to ready v LEf't:| 81 | Top: | 57 | Right: | 1839 | Bottom: | 905
Action 4: | Exit from not connected v | Leftlo | Top: [980 |Right: [ 150 | Bottom:
Action 5: | Exit from standby v | Leftflo | Top: [980 | Right: [ 150 | Bottom:
Action & | Close playback | Left( 827 |Top: (972 |Right: | 1082 | Bottom: | 1070
Action 7: | Brighter w LEf't:| 0 | Top: | 2 | Right: | 109 | Bottom: | 119
Action 8: | Darker v | Leftflo | Top: [975 |Right: [ 113 | Bottom:
Action 9: Mo action s | Left:| O Top: | O Right: 0 Bottom: 0O
Action 10: | Mo action w | Left:| O Top: O Right: 0 Bottom: 0
Action 11: | Mo action ~ | Left:| O Top: O Right: © Bottom: 0
Action 12: | Mo action w [ Left:| O Top: | O Right: 0 Bottom: 0O
Action 13: | Mo action s | Left:| O Top: | O Right: 0 Bottom: 0O
Action 14: | Mo action w | Left:| O Top: O Right: 0 Bottom: 0
Action 15: | Mo action w | Left:| O Top: O Right: 0 Bottom: 0

Show/fedit touchscreen areas...

Cancel

Select the action using the dropdown lists on the left and the area on the touchscreen that activates
the action using the corresponding "Left", "Top", "Right" and "Bottom" edit boxes. The values entered
in the edit boxes are the screen coordinates in pixels with the origin in the top left corner.

Touchscreen actions can also be viewed or edited interactively using a mouse by clicking on the
"Show/edit touchscreen areas..." button. When the touchscreen action editor is first opened it will
display the ready.jpg screen and the touchscreen actions for as boxes with white outlines and green
text indicating the action. The action can be moved by clicking in the box and moving the mouse with
the left button held down. The size of the box can be adjusted by dragging the corners with the left
mouse button held down. Touchscreen actions can be deleted by right clicking on the action and
selecting "Delete action" from the menu. New actions added by right clicking the mouse and selecting
the "Add action...". Different screens can be displayed by right clicking the mouse and selecting the
required screen.

Exit the touchscreen action editor by pressing the escape key or by right clicking the mouse and
selecting "Exit" from the menu. If the touchsrceen actions have been modified a confirmation dialog
will be displayed asking you if you want to save the changes.

Please note: the touchscreen action editor only edits the positions of the touchscreen actions. It
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doesn't edit the JPEG screen images which display the graphics for the touchscreen buttons - to do
this you need to use an image editor such as Photoshop Elements.

In Operation

First set up the Multi-Camera Animator to create the animated GIFs or MP4 movies files and to
calibrate the photos from the cameras (see the "Creating Animated GIFs and MP4s" section) and set it
in "Run" mode.

Next set up the camera trigger to trigger the cameras with a suitable delay when using flash (see the "
ESPER TriggerBox" section).

Then set the camera exposure settings as required e.g. if using flash set the shutter speed to 1/30 or
1/60, the aperture to f8 and the ISO and flash power to get correctly exposed photos.

Select "Photo booth mode..." from the File menu. The trigger_connecting.jpg screen will be displayed
while connecting to the camera trigger system (this could take a few seconds). After it has connected
the ready.jpg screen should be displayed with live view images from the center camera.

Press the start or trigger cameras keyboard shortcut or tap the touchscreen to activate the "Start
countdown" touchscreen action.

Keyboard Shortcuts:

F3 - toggle live view on/off and switch between the ready.jpg screen (live view on) to the
ready_no_live_view.jpg screen (live view off)

Shift+F3 - disable live view from the middle camera and switch from the ready.jpg screen to the
ready_no_live_view.jpg screen

Ctrlt+F3 - enable live view from the middle camera and switch from the ready_no_live_view.jpg screen
to the ready.jpg screen

F4 - take photos immediately with no countdown (there will be a delay of about 1/2 sec while the live
view is canceled)

F5 - start the countdown

F6 - switch between ready and standby modes

Esc - exit photo booth mode

Note: When triggering the cameras using F4 the delay caused by cancelling live view from the middle
camera can be avoided by pressing F3 first. This allows live view to be used for the initial composition
and then disabled before taking the actual photos to reduce the delay in triggering the cameras. When
live view is disabled the cameras can be triggered directly using the camera trigger (e.g. with a remote
release switch connected to the input of an ESPER TriggerBox). The cameras can't be triggered
directly when live view is active (except by pressing F4) because the shutter lag is longer when live
view is active and the middle camera won't take its photo in sync with the other cameras.

Using other camera triggers

Other camera triggers can be used to trigger the cameras in photo booth mode by using
PhidgetsinterfaceKit relays. Either the PhidgetintefaceKit 0/0/8 or PhidgetinterfaceKit 0/0/4 can be
used. The PhidgetintefaceKit 0/0/8 has small signal relays and is more suitable for this application.
Please visit the Phidgets website (www.phidgets.com) for more information on their products.

Select File->Select trigger... and select "PhidgetsinterfaceKit" from the dropdown list in the "Camera
Trigger Selector" dialog:
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Carnera Trigger Selector >

Please select the camera trigger from the list below:

PhidgetsInterfacekit e

oK Cancel

If "PhidgetsinterfaceKit" does not appear in the dropdown list you need to install the Microsoft Visual
C++ 2010 SP1 Redistributable Package (x86). This can be downloaded from Microsoft's website.

Connect relay 0 to the AF input on the camera trigger and relay 1 to the shutter release input.
Run Multi-Camera and select File->Trigger setup...

Phidget Relay Setup X

Connected to Phidgets relay

Disconnect

Trigger Cameras

Warks with PhidgetsInterfacekit 0/0/4 ar
PhidgetsInterfacekit 0/0/8. Connect relay 0 to the
AF trigger input and relay 1 to the shutter trigger
inout,

Close

Press the "Trigger Cameras" button to trigger the cameras. You should hear the relays click on and off

when this is pressed.

If the setup dialog does not show the Phidgets relay is connected please check that the Phidgets
drivers are installed on the computer and that a PhidgetsinterfaceKit 0/0/4 or PhidgetsinterfaceKit
0/0/4 is connected to the computer via USB.

411 ESPER TriggerBox

The TriggerBox from ESPER provides a convenient way to trigger all the cameras at the same time. It
is particularly useful when using flash because it allows the flash to be triggered after a preset delay so
that it is in sync with the cameras.
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Each TriggerBox has 6 output channels. Each output can be programmed with a different delay and
can be used to trigger one or more cameras or flash units. The output sockets are standard 3.5mm
stereo sockets and can be connected to the remote release sockets on the cameras using standard
3.5mm to 2.5mm stereo cables.

Multiple TriggerBoxes can be daisy chained together by connecting the link output from the "master”
TriggerBox to input of the next TriggerBox and connecting its link output to the input of the next
TriggerBox in the chain etc.

Important: Only use stereo cables with standard 3 contact jacks. This is necessary to allow the AF
signal and the release signal to be used on each camera. Activating the AF signal shortly before the
release signal will give more accurate camera synchronization.

The TriggerBox is powered by a standard USB C cable. This should be connected to the computer
running Multi-Camera if you want to be able to use the photo booth mode or to adjust the TriggerBox
settings.

The TriggerBox has an input connection which can be used to trigger the cameras using a standard
camera remote release or wireless release. The Link connection can be used to link multiple
TriggerBoxes together when triggering large numbers of cameras. The link output from the main
TriggerBox should be connected to the input socket of the next TriggerBox (and its link output
connected to the input of the next TriggerBox and so on).

The TriggerBox also has a mode switch which should be glowing blue. If it is showing green you need
to press the mode button to select blue mode. Blue mode allows programmable delays on each
channel and control via the USB interface. Green mode disables the output delays and doesn't allow
triggering via USB.

The TriggerBox can be setup using ESPER's control software or by using a simplified interface
available by selecting File->Trigger setup... in Multi-Camera. Screenshots from the two tools are
shown below:
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MultiCameraRelease - Esper TriggerBox Setup X

Please note: The TriggerBox 'Mode' switch should be blue not green.

Firmware: Version 1.3 Disconnect
TriggerBox: 'master ~
Rename... Save settings to TriggerBox

Channel 1: [V/]Shutter []Focus  Delay (ms): | O

Channel 2: [/ Shutter [v|Focus  Delay (ms): |0

Channel 3: [/] Shutter []Focus  Delay (ms): |0

Channel 4:  [V/] Shutter []Focus  Delay (ms): | O

Channel 5: [/ Shutter [v|Focus  Delay (ms): | O

Channel 6: Shutter Focus  Delay (ms): | 118
Enable link

Trigger
Cameras

Close

Multi-Camera's simplified setup tool
If multiple TriggerBoxes are detected they can be selected using the "TriggerBox:" dropdown list.

Set the name of the TriggerBox to identify it. A name will be automatically assigned to each TriggerBox
which doesn't have one already. The first unnamed TriggerBox will be named "master" and the
remaining ones named "slave1", slave2" etc.

When multiple TriggerBoxes are used the TriggerBoxes are sorted alphabetically by name and the
command to trigger the cameras is sent to the first TriggerBox. Suggested naming scheme: first
TriggerBox: "master", remaining TriggerBoxes: "slave1", "slave2" etc. This will ensure trigger
commands are sent to the TriggerBox named"master".

Each channel has individual setting to enable its shutter release and focus (AF) output and a
programmable delay. When using flash channels 1 to 5 are normally used to trigger the cameras and
channel 6 is used for the flash.
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Enable the shutter and focus outputs for each camera channel and the shutter output for the flash
channel (the focus output may also be selected if required).

Normally when using flash the cameras need to be triggered first and the flash after a short delay so
that it fires when all the camera shutters are fully open. The settings in the screenshot above should
give good results when using a Canon EOS 1300D/Rebel T6. Different camera models may require
different settings.

Set "Enable link" when using multiple TriggerBoxes. This will send the AF and release signals to the
link output to Trigger the next TriggerBox in line. Please see the notes on using multiple TriggerBoxes
at the bottom of this page for more information.

Test photos can be taken by pressing the "Trigger Cameras" button.

Press the "Save settings to TriggerBox" button after adjusting the settings otherwise they changes will
be lost when the TriggerBox is turned off.

Syncing Multiple Cameras with Flash

The problem:

The flash needs to be triggered when the shutters from all the cameras are fully open otherwise the
images will show dark horizontal bands or will be completely dark. The shutter lag on each camera
(the delay between pressing the shutter release button and actually taking the photo) varies by a few
milliseconds. This is a problem because most flashes only last for about 1ms and so if the flash is
triggered from the hotshoe of one of the cameras it may go off before the other cameras are ready.
For example: if each camera has a shutter lag of between 100ms and 103ms and the flash is triggered
from the hotshoe of camera #1 the flash will be triggered too early if camera #1's shutter lag is 100ms
and camera #2's shutter lag is 103ms.

The solution:

Use the slowest acceptable shutter speed and trigger the flash after a delay so that it fires mid-way
through the exposure.

If the shutter speed is set to the normal flash sync speed (e.g. 1/200 sec) the camera's shutter will be
fully open for less than 5ms whereas if the shutter speed is set to 1/30 sec the shutter will be fully open
for around 30ms. Using a slower shutter speed does not affect the flash exposure (this is only affected
by the aperture and the ISO setting). By using a slower shutter speed we have a much bigger time
window in which the flash can be fired and reduces the chances of it being affected by small variations
in the shutter lags of each camera.

e.g. if each camera has a shutter lag between 100ms and 103ms and the shutter is fully open for
30ms the fastest camera will have its shutter fully open from 100ms to 130ms after it was triggered
and the slowest camera will have its shutter fully open from 103ms to 133ms. This means the flash
can be triggered any time between 103ms and 130ms after the camera trigger signal. |deally we want
to trigger the flash in the middle of this window i.e. 116ms after sending the trigger signal.

Note: Use the slowest shutter speed you can that is not affected by the ambient lighting i.e. gives dark
photos when the flash is turned off. If the ambient lighting is bright you may need to use a faster
shutter speed otherwise you may get some ghosting.

How to determine the correct flash delay

1) Setup:

Set the cameras to manual exposure with a shutter speed of 1/60 sec, aperture f8 and ISO 100.
Connect the cameras to channels 1 to 5 of the TriggerBox and the flash to channel 6.

Set the delays for channels 1 to 5 to 0 and the delay for channel 6 to 50.

2) Find the earliest time when all the shutters are fully open:

Press the "Trigger Cameras" button and check the photos taken by each camera - they should all be
too dark because the flash fired too early.

Add 10 to the delay for channel 6 and take another set of test photos.
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Keep repeating this, adding 10 ms to the delay until all the photos are bright and evenly lit.

Now subtract 1 from the delay and take another set of test photos. Keep subtracting one and taking
test photos until some of the photos are dark or not evenly lit.

Make a note of the shortest delay which gives bright, evenly exposed photos from all cameras.

3) Find the latest time when all the shutter are fully open

Add 10 to the delay found in step 2 and take a test photo. All the photos should still be bright and
evenly lit.

Keep adding 10ms to the delay and taking test photos until some of the cameras have dark photos or
are not evenly lit.

Now subtract 1 from the delay and take another set of test photos. Keep subtracting one and taking
test photos until all of the photos are bright and evenly lit.

This is the longest delay which gives bright, evenly exposed photos from all cameras.

4) Take the average time from steps 2 and 3 and set this as the delay for channel 6 e.g. if step 2 gave
a minimum time of 100ms and step 3 gave a maximum time of 116ms, set the delay to 108ms.

This will trigger the flash in the middle of the average exposure of all the cameras and will maximize
the chances of it being triggered when all the camera shutters are fully open.

5) Save the settings to the TriggerBox.

Notes on using multiple TriggerBoxes

Each TriggerBox has an input, a link output and six outputs to trigger cameras or flashes. One
TriggerBox can be used to trigger 5 cameras with flash or up to 10 cameras with flash by using splitter
cables on each output.

Larger numbers of cameras can be triggered by using multiple TriggerBoxes and daisy chaining them
together by connecting the link output from the first TriggerBox to the input of the next TriggerBox and
connecting its output to the next TriggerBox in line and so on.

cameras/flash cameras/flash cameras/flash

12 3 4 5 6 1 2 3 4 5 6 12 3 4 5 6

TriggerBox TriggerBox TriggerBox
“master” “slave1” “slave2”

input link mode USB input link mode USB input link mode USB

Wired or wireless
remote release

computer or
USB power

If you are using photo booth mode the cameras will be triggered by the computer sending a command
via the TriggerBox's USB interface. If multiple TriggerBoxes are connected to the computer it is
important to name them so that the command is sent to the correct TriggerBox. The names are sorted
alphabetically and the command is sent to the first TriggerBox e.g. if the TriggerBoxes are named
"master”, "slave1", "slave2" etc. the command will be sent to the TriggerBox named "master". The
"master" TriggerBox needs to be connected to the computer controlling the cameras so that it receives

the USB command to trigger the cameras. The remaining TriggerBoxes can be either be connected to
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the same computer or to USB power supplies. Once the TriggerBoxes have been programmed and
the settings saved they can be connected to USB power adapters. This reduce the time it takes to
connect to the TriggerBoxes when selecting photo booth mode.

IMPORTANT: Please check that each TriggerBox has firmware version 1.3 or later if they are to be
powered from USB power adapters. This is because there is a problem with the AF signal not being
sent to the link output when using firmware version 1.2. This will cause the camera sync to be
unreliable: to get reliable sync you need to set AF (or half-press the shutter release) and then trigger
the cameras.

If you are not using photo booth mode the cameras can be triggered by connecting a wired or wireless
remote release to the master TriggerBox. This will work with all versions of TriggerBox firmware
provided the "Enable link" option is selected in the TriggerBox settings.

5 Time Lapse

Select "Time-lapse..." from the "Camera" menu to take time-lapse shots.

The time lapse sequence can be set to start immediately or to start at a particular
time and date. You can either specify an end time and date for the time lapse
sequence or the number of frames in the sequence.

You can specify the interval between shots.
Note: If you set the interval to a time shorter than that required to take and download
the picture the sequence will run as fast as possible.

Press the "Start" button to start the time lapse sequence.

Time Lapse
Skart End
(%) Stark immediately (%) Mumber of frames: | 10
(" Set skart date and kime () Set end date and time

Interval between frames (secs): | 30

Skatus: 14:20:01
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Running Multi-Camera from other apps

Overview

Multi-Camera includes an interface library called DSLRRemoteLib.dll which can be
used by other applications to control Multi-Camera. Also included is a simple
command line application called DSLRRemoteTest.exe which can be used to control
Multi-Camera from a command prompt or a batch file. For example a batch file could
be written to take a series of photos using different apertures and shutter speeds to
bracket the exposure.

Important: Please select "Use legacy app name" in Preferences before using
DSLRRemoteLib.dll or DSLRRemoteTest.exe. The libraries will only work if this
option is selected so that the program name is displayed as "DSLR Remote Pro
Multi-Camera".

DSLRRemoteLib.dli

DSLRRemoteLib.dll is a library that can be used by other programs to control Multi-
Camera. It can be found in the main folder where Multi-Camera is installed (usually
C:\Program Files\Breezesys\Multi-Camera). Please see the
DSLRRemoteTest\ReadMe.txt and DSLRRemoteLib.h files for details.

Files included:
DSLRRemoteTest.exe - compiled console application

DSLRRemoteLib.dll - DLL used by DSLRRemoteTest.exe to interface with Multi-
Camera

DSLRRemoteLib.lib - lib for C++ apps to link to the DLL

DSLRRemoteLib.h - header file for C++ applications using the DLL

DSLRRemoteTest - directory containing a VC++ project and source code for
DSLRRemoteTest.exe

DSLRRemoteTest.exe

DSLRRemoteTest.exe is a simple command line application that communicates with
Multi-Camera and allows the shutter to be released and some of the camera settings
to be changed. DSLRRemoteTest.exe and complete source code to build it using
Visual C++ .Net can be found in the DSLRRemoteTest folder where Multi-Camera is
installed (usually C:\Program Files\Breezesys\Multi-Camera).

To run DSLRRemoteTest.exe first run DSLR Remote Pro and then open a
command prompt window and change directory to the Multi-Camera installation
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folder. The run DSLRRemoteTest.exe -h to get a list of the available commands.

Here is the output from a simple session where the output directory is set and the
shutter is released (commands typed in by the user are shown in bold):

Microsoft Windows XP [Version 5.1.2600]
(C) Copyright 1985-2001 Microsoft Corp.

C:\>cd C:\Program Files\Breezesys\Multi-Camera

C:\Program Files\Breezesys\Multi-Camera>DSLRRemoteTest.exe -h

Usage: DSLRRemoteTest [-w [<shots>] [-1 <interval>]] [-a <aperture>] [-s
<shutter>]

-h print this usage information

-w <shots> run camera as a webcam for <shots> shots

images are saved as webcam.jpg in the current

directory

-t <interval> specify the number of seconds between shots when

used as a webcam

-S <camera#> select camera (multi-camera versions of DSLR Remote
Pro only)

-C <connect> connect or disconnect from the camera

-a <aperture> set the aperture, 0 = widest aperture

-b <WB> set the white balance or kelvin color temp

-e <mode> set the exposure mode (1D series cameras only)

-s <shutter> set the shutter speed, 0 = longest shutter speed

-x <comp> set the exposure compensation

-1 <quality> set the image size and quality

-I <ISO> set the ISO

-c <comment> set comment to be added to images (max 255 chars)

-p <prefix> set the filename prefix (max 255 chars)

-0 <directory> set the output directory

-q query output directory

-n don't release shutter

C:\Program Files\Breezesys\Multi-Camera>DSLRRemoteTest.exe -n -o C:\Photos
-q
Output directory: C:\Photos\2004-01-15\

C:\Program Files\Breezesys\Multi-Camera>DSLRRemoteTest.exe
Success, image saved as: C:\Photos\2004-01-15\IMG 0001.JPG

C:\Program Files\Breezesys\Multi-Camera>
[****]

7 Preferences

Click on "File->Preferences" to display the preferences dialog.
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Multi-Camera Preferences

Mouse button actions

Middle button:| None “ | Right button: | None ~

[ ]only download JPEGs to PC when shooting raw +IPEG
Gang camera shutter releases together, delay in ms: IZI

Gang camera settings together Sort cameras by Author
[ synchronize multiple copies of Multi-Camera:

Saved image settings
[ ]Prefix flename with comment string [ ] Lower case file extensions

[ ] Append sequence letter to end of filenames when auto-bracketing
|:| Sortimages into groups

Filename prefix: |{auﬁ'u:ur}_ | Digits: :

Directory in which to save images:
| Ci\Multi-Camera |

Separate directory for: [~ Year Month Day
[~]Flatten date (e.g 2021-01-14)

Sub-folder: |

Example image name:

| C:\Multi-Cameral2021-01-14\{authar}_0123.1PG

[ Juse legacy app name Cancel

Mouse Button Actions

The middle and right mouse buttons can be assigned to release the shutter or take
pictures in preview mode. This allows you to use the mouse like a simple cable

release.

Note: This only works if the mouse pointer is over the main window and is not over

one of the controls.

Multi-Camera Options

The "Only download JPEGs to PC when shooting raw+JPEG" option is useful if you
want to shoot raw files for the best possible quality but wish to reduce the download
time when taking pictures and download JPEG files to the PC to check the photos.

This option only has an effect if all the cameras have memory cards and the saving
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of images to both the camera and the PC is selected (Camera->Save to camera &
PC). The "Download photos" dialog can be used to download the raw and JPEG
photos later.

When "Gang camera shutter releases together" is selected a picture will be taken
with all connected cameras when the "Release" button is pressed in the main
window. When this option is not selected a picture will only be taken with the current
camera shown in the "Camera:" dropdown list in the main window.

Please note: When pictures are taken by pressing the "Release" button in the main
window with the "Gang camera shutter releases together" option selected the
cameras will take pictures one after the other with a delay of approximately 1/6 sec
between each camera. Please trigger the cameras via the remote shutter release to
fire them at the same time (see our website for details).

When "Gang camera settings together" is selected any changes made to the
settings for one camera are applied to all connected cameras.

Copies of Multi-Camera running on different computers can be synchronized by
selecting the "Synchronize multiple copies of Multi-Camera" option. This works by
monitoring a file called settings.xml stored in the "status" subfolder of the main
download directory. When the settings are changed in one copy of DSLR Remote
Pro it writes the changes to the settings.xml file, the remaining copies detect that the
file has been changed and update their settings accordingly. For this to work the
computers need to be networked together and the download directory for each copy
should be set to the same shared folder. Alternatively the synchronization folder can
be specified separately using the "Directory:" text edit box below the "Synchronize
multiple copies of Multi-Camera" checkbox. This allows multiple copies of Multi-
Camera to be synchronized via a shared folder and images to be downloaded to a
separate folder which can be on the PC's local hard disk if required.

An audible confirmation of each computer updating its settings can be played by
placing a WAV sound file called updated.wav in the Multi-Camera installation folder.

When the "Sort cameras by Author" is selected the cameras will be sorted by the
"Artist" string stored in the camera. When it is not selected the cameras will be
sorted by the "Owner" string. Sorting by "Author" has the advantage that the "Author"
string can be entered in a camera when it is not connected to the PC whereas the
"Owner" string can only be edited by connecting the camera and selecting Camera-
>Edit camera id.

The "Sort images into groups" sorts the images alphabetically so that when the next/
prev image buttons are used to view images they are displayed in camera order.
When this option is not selected the images are displayed in the order in which they
were downloaded which may not be the same as the camera order.

Specifying the output directory
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These settings control where images are stored on the computer's hard disk. The
edit box displays the base directory for images and can be changed by typing
directly into the edit box or by clicking on the "..." button and using the directory
browser. If the Year, Month and Day checkboxes are not checked this will be the
directory in which all images are stored.

Note: If the directory does not already exist it will be created when the photo is
saved.

The Year, Month and Day checkbox control the automatic generation of
subdirectories according to the computer's date. The example image name shown at
the bottom of the dialog shows how the various settings are combined. Select the
"Flatten date" checkbox to combine the year, month and day into a single
subdirectory e.g. in the example above:

January 14, 2004 with "Flatten date" unchecked gives "C:\DSLRRemote\2004\01\14"
With "Flatten date" checked it gives "C:\DSLRRemote\2004-01-14"

You can also use the IPTC tokens to when specifying the output directory e.g. "C:\%
Y\%T" would give the year followed by the camera model.

Image Filenames

Multi-Camera stores images using a numeric sequence number when they are
saved to the PC's hard disk. It scans the output directory for existing images and
uses the lowest available sequence number e.g. if the output directory already
contains the image 0123.JPG Multi-Camera will save the next image as 0124.JPG.
Multi-Camera will then continue numbering from that point even if the images are
removed from the directory while it is running. This is to prevent duplicate filenames
when images captured by Multi-Camera are immediately removed from the output
directory e.g. when using a program to automatically send the images to a picture
desk using FTP.

JPEG images are saved with a .JPG file extension e.g. 0001.JPG, 0002.JPG etc.

Raw images are saved with a .CR2 file extension. If raw+JPEG mode is selected the
JPEG image will be saved as the same filename as the raw file but with a .JPG file
extension e.g. 0001.CR2 and 0001.JPG.

You can specify an optional prefix to be added at the start of each image's filename
e.g. the prefix "studio shoot " would result filenames like "studio shoot 0001.JPG",
"studio shoot 0002.CRW" etc.

You can also use the IPTC tokens to when specifying the output directory e.g. "C:\%
Y\%T" would give the year followed by the camera model.

When "Append sequence letter to end of flenames when auto-bracketing" is

© 2021 Breeze Systems Ltd



Preferences 71

selected auto-bracketed filenames have the same image number and a sequence

letter added to each shot for easy identification. e.g. a 3-shot sequence might give

filenames 0001a.JPG, 0001b.JPG and 0001c.JPG as opposed to 0001.JPG, 0002.
JPG and 0003.JPG when this option is switched off.

Please note: When saving images to both the CF card and the PC the filenames
stored on the CF card and the PC will be different. This is because it isn't possible
for Multi-Camera to read the filename used by the camera and has to generate a

local filename instead.

By default the filename is made up of the filename prefix followed by a four digit
image number. The placement of the image number can be changed by using the
token %# in the prefix.

e.g. To place the image number at the start of the filename set the prefix to
something like %# test. This will give filenames like 0001_test.JPG, 0002_test.JPG
etc.

Filenames for saved images and movie files normally have upper case file
extensions e.g. IMG_0001.JPG. If the "Lower case file extensions" checkbox is
selected image filenames will be given lower case file extensions e.g. IMG_0001.jpg.

Use Legacy App Name

This option sets the progam title displayed in the Windows title bar of each window
to the app's old name: "DSLR Remote Pro Multi-Camera" as opposed to its current
name: "Multi-Camera".

Important: Select this option if you wish to use the DSLRRemoteLib.dll library to
control Multi-Camera from another app.

8 IPTC tokens

Date and time tokens

%a Abbreviated weekday name e.g. Fri

%A Full weekday name e.g. Friday

%b Abbreviated month name e.g. Jun

%B Full month name e.g. June

o4d Date in the form YYMMDD (equivalentto | e.g. 030611 for June
° %y%m%D) 11,2016

%D Day of the month (01 to 31)

%H Hour (00 to 23)
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%I
%]

%l

%L

%m
%M
%op
%S

%t
%W
%x

%X
Yoy
%Y

%z

%Z

%l
%2
%3

{year}
{month}

{day}

{yearLess8h}
{monthLess8h}

{dayLess8h}

Hour (01 to 12)
Day of the year (001 to 366)

Long date/time representation of locale

Long date representation for locale

Month (01 to 12)
Minutes (00 to 59)
am/pm indicator
Seconds (00 to 59)

Time in the form HHMMSS (equivalent to %
H%M%S)

Week number (00 to 53)
Date representation for locale

Time representation for locale
Year without century

Year with century

Time zone name

Time zone offset wrt UTC

Year 'now' in the form YYY'Y
Month 'now' (01 to 12)

Day now' (01 to 31)

Year 'now' in the form YYYY
Month 'now' (01 to 12)

Day now' (01 to 31)

Same as {year} except using the current time
less 8 hours

Same as {month} except using the current
time less 8 hours

Same as {day} except using the current time
less 8 hours

e.g. Wednesday,
December 17,2016
19:03:47

e.g. Wednesday,
December 17, 2016

e.g. 06 for June

e.g. PM

e.g. 06 11 03 for
June 11, 2017

e.g. 14 39 29
e.g. 03
e.g. 2017

e.g. GMT Standard
Time

e.g. 0100 for GMT
during DST

e.g. 2017
e.g. 06
e.g. 20
e.g. 2017
e.g. 06
e.g. 20

e.g. 2017
e.g. 06

e.g. 20

© 2021 Breeze Systems Ltd



IPTC tokens

Shooting data tokens

{camera#}

%c
%C

%e

%i
%0
%0

{orientation}

{orientationAngle}
{owner}

{author}
{artist}
{copy}
{copyright}
%T

%T1
%T2
%T3
%T4
%T5

%T6

%V

%V

Other tokens

{comment}

Camera number as displayed in cameras
dropdown list

Camera serial number
Canon EOS-1D/1DS style camera serial number

File extension (without the '.")

ISO value read from the shooting data
Image filename without extension
Owner string stored in the camera

Image orientation: L for landscape or P for
portrait

Image orientation angle in degrees: 0, 90 or 270
Owner string (same as %O0)

Author string stored in the camera (newer
camera models only)

Author string (same as {author})

Copyright string stored in the camera (newer
camera models only)

Copyright string (same as {copy})

Camera model name starting from the first word
containing digits

Same as %T, but '-' are treated as spaces

Full camera model name

First word of camera model name containing
digits

Same as %T3, but '-' are treated as spaces
Last word of camera model name containing
digits

Same as %T5, but '-' are treated as spaces
Camera model name starting from the first word

containing digits
(same as %T)

Full camera model name (same as %T2)

The value of comment entered in the main

73

e.g. 1

e.g. JPG for IMG_4567.

JPG

e.g. IMG_4567

e.g. 10D for Canon
EOS 10D

e.g. 1DS for Canon
EOS-1DS

e.g. Canon EOS 10D

e.g. 10D for Canon
EOS 10D

e.g. 1DS for Canon
EOS-1DS
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window
e.g. IMG_%# {owner}
ot Specifies where to place the image number when | places the image
° used in the filename prefix number before the

owner string

Release History

18 January 2021: v2.1.3

Added support for the Canon EOS R5

Added support for the Canon EOS R6

Added support for the Canon EOS M6 Mark Il

Added support for the Canon EOS M50 Mark Il/Kiss M2

Added support for the Canon EOS 850D/Rebel T8i/Kiss X10i

Added support for multiple animation frames per photo to the Multi-Camera Animator

Added "Use legacy app name" option to allow the DSLRRemoteLib.dll interface library to be used to
control the app from other apps

31 July 2019: v2.1.2
o Fixed an issue with downloading videos from recent camera models which save them as MP4 files

24 July 2019: v2.1.1

e Added support for Canon EOS RP

o Added support for Canon EOS 250D/Rebel SL3 (aka Canon EOS 200D Il and Canon EOS Kiss
X10)

o Faster creation of MP4 video files using the MediaWriter option in the Multi-Camera Animator

¢ Fixed a reliability issue when playing videos in photo booth mode that was caused by recent
Windows updates

28 November 2018: v2.1

e Added support for the Canon EOS R

¢ Photo booth mode now supports cameras in portrait orientation

¢ Photo booth mode can now display MP4 files full screen behind the live view images

o Added a ready_no_live_view.jpg screen to photo booth mode to allow cameras to be triggered with
minimal latency

¢ Added the option to save GIFs and MP4s with UID filenames

e Shortened the product name to "Multi-Camera"

24 July 2018: v2.0

Added photo booth mode

Added support for configuring the ESPER TriggerBox camera trigger

Added support for Canon EOS 2000D/Rebel T7 (aka Canon EOS 1500D and Canon EOS Kiss X90)
Added support for Canon EOS 4000D (aka Canon EOS 3000D)

Added support for Canon EOS M50 (aka Canon EOS Kiss M)

MP4 files can now have an optional soundtrack

¢ Clicking on bottom or top reference points when aligning an image now scales as well as rotates

11 December 2017: v1.9.5

o Added support for the Canon EOS 6D Mark I

o Added the option to save the current calibration settings with each set of downloaded photos

¢ Added the option to run a command after saving the calibration settings after processing each set of
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photos
¢ Updated the auto alignment tool to work with images in portrait orientation
e The Multi-Camera Animator now supports raw+JPEG shooting

8 August 2017: v1.9.4

o Added support for the Canon EOS 200D/Rebel SL2

o The File->Setup for Multi-Camera Animator... option now checks that camera author strings have
been set and are unique

o Fixed a problem with the Picture style setting being hidden in the main window

29 June 2017: v1.9.3

¢ Added support for the Canon EOS 77D and Canon EOS 800D/Rebel T7i

¢ Added auto alignment option to the Multi-Camera Animator

o Can now use {year}, {month}, {day}, {yearLess8h}, {monthLess8h}, {dayLess8h} tokens to create
date based folders when using the Multi-Camera Animator

e MP4 creation when using the Multi-Camera Animator now handles images from arrays containing a
mixture of different camera models which may have slightly different aspect ratios

7 March 2017: v1.9.2

¢ Multi-Camera Animator updated to allow the mouse to be used to calibrate the camera alignment,
greatly reducing the time required for calibration

¢ Additional warning messages displayed in the Multi-Camera Animator if it detects that DSLR
Remote Pro Multi-Camera is not set up correctly

¢ Added a menu item to the File menu to check the settings are set correctly for using the Multi-
Camera Animator

o Added the ability to save the Multi-Camera Animator settings to file and to load them by drag and
drop or via the command line

2 November 2016: v1.9.1

Added support for the Canon EOS 5D Mark IV

Added multi-view mode which displays a grid showing the previews from each camera

The Multi-Camera Animator utility now supports the creation of MP4 files

GIFs created using the Multi-Camera Animator utility can now use indexed color to give better detail
Added a menu item to the File menu to launch the Multi-Camera Animator utility

4 August 2016: v1.9

o Added support for the Canon EOS 1300D/Rebel T6, Canon EOS 80D and Canon EOS-1D X Mark I

¢ Added optional buttons in live view to make it easier to select cameras and zoom live view when
using a touchscreen

o Added Multi-Camera Animator utility to stabilize the photos from the cameras and automatically
create animated GIFs

15 July 2015: v1.8.2

e Added support for the Canon EOS 5DS and Canon EOS 5DS R

o Fixed a problem with a simplified GUI being displayed in v1.8.1

¢ Fixed a problem naming raw+JPEG files when the filename prefix contains %#

24 June 2015: v1.8.1
Added support for Canon EOS 7D Mark Il
Added support for Canon EOS 750D/Rebel T6i and Canon EOS 760D/Rebel T6s

¢ Added the option to shoot raw+JPEG with raw and JPEGs saved to the cameras' memory cards and
the JPEGs downloaded to the PC

Added the option to download photos saved to the cameras' memory cards
Fixed a problem enabling and disabling mirror lockup with some camera models (e.g. Canon EOS
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100D/Rebel SL1)

9 April 2014: v1.8

¢ Auto-reconnect mode now adds new cameras automatically as they are detected and disconnects
cameras that go off line without disconnecting all cameras

¢ Added support for the Canon EOS 1200D/Rebel T5

o Added Shift+F8 keyboard shortcut to take photo with only the currently selected camera when "Gang
camera shutter releases together" is selected

¢ Added the option to sort cameras by author string or owner string

o Fixed a problem with anaglyph stereo not working in multi-live view that affected DSLR Remote Pro
Multi-Camera versions 1.7.4 and 1.7.5

6 December 2013: v1.7.5
¢ Added support for the Canon EOS-1D C

27 September 2013: v1.7.4
o Added support for the Canon EOS 70D

22 June 2013: v1.7.3.1

¢ Fixed a problem in DSLR Remote Pro Multi-Camera v1.7.3 which limited the registered version of
the software to only being able to connect to 2 cameras

13 June 2013: v1.7.3
o Added support for the Canon EOS 700D/Rebel T5i
¢ Added support for the Canon EOS 100D/Rebel SL1

23 January 2013: v1.7.2

o Added electronic level display in single camera live view for the Canon EOS 6D, Canon EOS 5D
Mark 1ll and Canon EOS-1D X. This is selected by typing Ctrl+E or by right clicking on the live view
display and selecting the "Display electronic level" menu option

¢ Added the ability to select mirror lockup with the following cameras: Canon EOS-1D X, Canon EOS-
1D Mark IV, Canon EOS-1D Mark lll, Canon EOS-1Ds Mark Ill, Canon EOS 7D, Canon EOS 6D,
Canon EOS 5D Mark lll, Canon EOS 5D Mark Il, Canon EOS 60D, Canon EOS 50D, Canon EOS
40D, Canon EOS 650D/Rebel T4i, Canon EOS 600D/Rebel T3i, Canon EOS 550D/Rebel T2i,
Canon EOS 1000D/Rebel XS

o Fixed a problem displaying the camera owner string in the camera settings dialog
o Multi-camera live view now supports the display of live view images from up to 36 cameras

9 January 2013: v1.7.1
o Added support for the Canon EOS 6D

6 November 2012: v1.7

¢ Added support for the Canon EOS-1D X

¢ Added a new "single camera per instance" mode which allows several copies of DSLR Remote Pro
Multi-Camera to be run with each connected to one camera. This can provide a more resilient
solution with faster download speeds than controlling multiple cameras from a single PC

e The option to synchronize multiple copies of DSLR Remote Pro Multi-Camera can now use one
folder for synchronizing settings and a different folder for downloading images

¢ Live view display can now display a PNG overlay file to aid camera alignment

e 24 September 2012: v1.6.1.1
o Fixed a problem scanning barcode letters using some barcode readers

14 August 2012: v1.6.1
o Added support for the Canon EOS 650D/Rebel T4i
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¢ Barcode input now accepts letters as well as digits

11 June 2012: v1.6
¢ Added support for the Canon EOS 5D Mark Ill

¢ Added the option to flip and mirror the live view image when using the stereo anaglyph display option
in multi-live view display with two cameras

12 October 2011: v1.5.3

o Added the ability to set the exposure mode from the PC with the following camera models: EOS
500D/Rebel T1i, EOS 550D/Rebel T2i, EOS 1000D/Rebel XS, EOS 40D, EOS 50D, EOS 7D, EOS
5D Mark Il

¢ Added red/cyan stereo anaglyph display option to multi live view display when using two cameras

¢ Added {author} and {copyright} tokens for accessing author and copyright information stored in
images from newer camera models to allow more flexible file naming

o GetCameraModel() function in DSLRRemoteLib.dll now returns owner string with camera model
name

12 April 2011: v1.5.2
e Added support for Canon EOS 600D/Rebel T3i and Canon EOS 1100D/Rebel T3

21 February 2011: v1.5.1
¢ Fixed problems with the software crashing on some systems (mainly Windows XP)

22 November 2010: v1.5
o Added support for Canon EOS 60D
o Added option to use lower case file extensions for filenames of saved images

29 June 2010: v1.4.1
¢ Fixed problems downloading videos and synchronizing camera clocks

14 May 2010: v1.4

o Added initial support for video capture using multiple cameras

o Multi Live View dialog is now non-modal to allow camera settings to be changed via the main
window

23 March 2010: v1.3.3
o Added support for the Canon EOS 550D/Rebel T2i

26 February 2010: v1.3.2
o Fixed a problem selecting longest shutter speed with recent cameras when auto-bracketing
¢ Fixed incorrect links to website purchase page

27 January 2010: v1.3.1
¢ Added support for the Canon EOS-1D Mark IV
o Improved reliability when taking bursts of shots with multiple cameras

11 December 2009: v1.3

¢ Added support for the Canon EOS 7D

¢ Fixed problems with saving images to the camera only

¢ Now supports multiple camera control on Windows 7 (32-bit and 64-bit versions) and Windows Vista
(32-bit versions)

14 May 2009: v1.2.2
o Added support for the Canon EOS 500D/Rebel T1i
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Extended auto-bracketing steps from a maximum of 2 stops to 4 stops per shot

Now supports auto-bracketing of multiple cameras (but not in raw+JPEG shooting mode)

Added option to format memory cards in the connected cameras

Removed spurious error message caused by a bug in the 40D, 50D and 5D Mark Il when shooting
with the drive mode set to self-timer 10 secs

o Added option to play sound file called updated.wav when updating settings via a network

o Added simultaneous live view display from all connected cameras which support live view

21 November 2008: v1.2.1

o Added support for the Canon EOS 50D and Canon EOS 5D Mark I

o Added %# token for filenaming to allow image numbers to be placed at the start of the filename for
easy sorting

¢ Added circle/ping-pong options for the order in which images are displayed in the sequence window

¢ Now supports the synchronizing of camera settings when running controlling cameras using multiple
PCs networked together

9 October 2008: v1.2

Added support for the Canon EOS 1000D/Rebel XS

Added sequence viewer to display a slideshow of images in a folder

Added subfolder option for easy creation of new subfolders

Added the ability to synchronize the settings between multiple copies of DSLR Remote Pro Multi-
Camera running on different PCs

24 April 2008: v1.1
o Added support for the Canon EOS 450D/Rebel XSi

¢ Error and warning messages now cancel automatically after 10 secs when camera auto-reconnect is
selected

23 January 2008: v1.0.6
o Fixed a problem with image filename numbering when saving files

4 December 2007: v1.0.5
¢ Added support for Canon EOS-1Ds Mark Il

13 October 2007: v1.0.4
o Added support for Canon EOS-1D Mark Il and Canon EOS 40D

29 June 2007: v1.0.3
e Added support for Windows Vista.
Note: due to a bug in the Canon SDK this does not work if all the cameras are the same model

10 May 2007: v1.0.2
e Minor updates to DSLRRemoteL.ib.dll
¢ Now supports time-lapse when images are saved to camera only

18 April 2007: v1.0.1
e Updated DSLRRemoteLib.dll to support multi-camera operation

10 January 2007: v1.0

o First public release with support for multiple Canon EOS 30D or Digital Rebel XTi/400D cameras on
Windows XP
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